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qtVlm is developed in the hope that it will be useful, but without any guaranty. qtVlm does not replace 

traditional navigation methods, nor printed paper charts. 
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Quick Start 

Installation 

qtVlm versions for PC (Windows/Linux/MacOS) as well as Raspberry PI2, PI3 and PI4 are available here:  

http://www.meltemus.com 

Mobile versions (Android et iOS) are available through their respective stores. More information about 

mobile versions at the end of this introduction. 

In all cases and on all platforms, you will be asked to download qtVlm’s maps (gshhs), the first time. 

Windows: 

Installing is made through qtVlm’s installer. 32 bits Windows versions are not supported anymore, except 

for the Windows tablet version. Minimum Windows version is Windows 7. 

Linux 

 Installation is made by uncompressing the gz archive. Then to start qtVlm just  run “./qtVlm”. A directory 

“.qtVlm” containing user data will be created. Please note that qtVlm must be launched from it’s 

directory. 

Note 1: On some Linux distributions you might need to also install SSL libraries. 

Note 2: If you get a message concerning XCB at startup, especially on Ubuntu 20.04 and after, then you 

should probably run: 

sudo apt install libxcb-xinerama0 

Note 3: You should not install qtVlm in a directory with a path containing special characters like accents. 

  

http://www./
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MacOS: 

Just double-click on qtVlm_install which is located at the root of the DMG. It will ask you for an installation 

folder, which must either be empty or contains a previous installation of qtVlm. 

Alternatively, you can install qtVlm by copying the folder “qtVlm” contained in the DMG somewhere on 

your local disk. Then you can run qtVlm from this local folder. It is not possible to run qtVlm directly from 

the DMG disk. 

Raspberry:  

In a terminal, un-compress the archive with the command: 

tar zxvf qtVlm-5.12.7-rpi.tar.gz 

then you can run qtVlm with: 

cd qtVlm 

./qtVlm 

Please note that qtVlm must be launched from its directory. 

You can also run: ./qtVlm_touchscreen for a pure tactile version. 

Note 1: On some old versions of Raspbian, for instance Jessie coming together with openPlotter, it is 

necessary to launch qtVlm with: 

./qtVlm -platform xcb 

Note 2: If you want to create a shortcut for qtVlm on Raspberry on the desktop, you can follow 

instructions contained in the file instructions_launcher_rpi.txt 

Note 3: it has been reported some issues with sound and RPI4/latest OS. If you have this problem, you 

can try: 

sudo apt -y purge "pulseaudio*" and reboot. 

Note 4: You should not install qtVlm in a directory with a path containing special characters like accents. 

Note 5: On some recent Raspi versions, you can have a problem with xcb although all is installed correctly. 

If that is the case, you can try: 

cd /usr/lib/arm-linux-gnueabihf 

ln -s libxcb-util.so.1 libxcb-util.so.0 
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Polar files 

Via the menu “boat->boat settings” you can choose a polar for your boat. qtVlm comes with some typical 

polar files, and you can easily create or import a personalized one. It is possible to alter a polar by applying 

a coefficient on it, you can specify delays for tacking and gybing, or under which speed you decide to start 

the engine, etc. There is also the possibility to define “waves polar”, describing the behavior of the boat 

depending on sea conditions. 

 

More about polar files 

Environment 

qtVlm is divided in several areas: the toolbar and the main menu, the map and its objects, instruments 

and status bar, plus several boards. The main dashboard is displayed or hidden by clicking on the 

microboard, on the right side of the screen, or through the dedicated icon on the toolbar. 

 

 The selection tool can be used to select an area on the map and can also be invoked with the mouse 

and the <shift> key. 

More about qtVlm environment 
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Gribs and Weather Images 

qtVlm can open or download a wide number of grib types, being grib 1 or grib 2. There are 3 slots where 

a grib can be loaded. One can for instance load a Winds grib in the first slot, and a Currents grib in the 

second one. It can also be used to load gribs with the same data at different resolutions. Data displayed 

on the map can be configured fully through the grib display control available in the toolbar. qtVlm 

will always use the data with the better resolution, regardless of the slot number. 

It is also possible to configure custom grib addresses for all three slots, for instance:  

qtVlm is Iridium GO! certified for Android and iOS. It can request and receive gribs via “Iridium Mail and 

Web” or XGate applications. 

qtVlm can download directly gribs from Xygrib and Squid, eventually through Iridium GO!. 

ftp://ftp.bsh.de/Stroemungsvorhersagen/grib2 (Currents North Europ) 

SKIRON gribs are also a very useful resource: 

https://www.openskiron.org/gribs_wrf_4km 

https://www.openskiron.org/gribs_wrf_12km 

https://www.openskiron.org/gribs_skiron 

https://www.openskiron.org/gribs_icon_eu 

https://openskiron.org/gribs_icon-d2_latest 

https://www.openskiron.org/saildocs  

qtVlm also allows to display weather images over the map. It accepts all image formats, and up to 8 slots 

can be pre-configured. Since version 5.7.3 it can also display kml and kmz images for instance from: 

https://ocean.weather.gov/gis/index.php 

https://earthdata.nasa.gov/earth-observation-data/near-real-time/rapid-response/modis-subsets 

 

More about gribs and weather images 

  

ftp://ftp.bsh.de/Stroemungsvorhersagen/grib2
https://www.openskiron.org/gribs_wrf_4km
https://www.openskiron.org/gribs_wrf_12km
https://www.openskiron.org/gribs_skiron
https://www.openskiron.org/gribs_icon_eu
https://openskiron.org/gribs_icon-d2_latest
https://www.openskiron.org/saildocs
https://ocean.weather.gov/gis/index.php
https://earthdata.nasa.gov/earth-observation-data/near-real-time/rapid-response/modis-subsets


13 
 

Charts 

Several map types are available (menu “qtVlm->Configuration”). 

 

Gshhs and mbtiles charts 

These charts are the gshhs maps, which in fact contains the coast lines used by qtVlm in Routes and 

Routings modules, and mbtiles charts. It is also there that are managed charts coming from Visit My 

Harbour. 

Online charts 

VLM tiles are the identical to gshhs maps, plus some color to represent altitude. 

OpenStreetMap tiles, available on mobile (Android et iOS) only, 

OpenSeaMap tiles, which can be displayed over any other type of maps, 

Wikimedia tiles, 

OpenTopoMap tiles. 

Raster and Vector charts 

Vectors charts (S57) are supported by qtVlm. IHO Certified, qtVlm also reads S63 charts like the one 

sold by chartworld or other chart providers. CM93 charts are also supported. 

qtVlm can also display georeferenced maps in kap, geotiff, geojpeg, etc format. A folder containing 

these maps can be configured, or these maps can just be copied in qtVlm default kaps folder. NVCharts 

are supported only on Windows platform. 

Similarly, qtVlm can read and display maps in mbtiles format, that also just must be copied in a dedicated 

folder.  

http://www.visitmyharbour.com/
http://www.visitmyharbour.com/
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Charts type selection from toolbar  

The choice between the different chart types can be made directly using the toolbar. 

 

These icons let you choose between Online charts, Raster charts, Mbtiles charts, Vector charts and CM93 

charts. 

An option available in the configuration screen allows to choose whether rasters are displayed over or 

under mbtiles, in case both maps are available for the area. 

Another parameter defines if the grib is displayed over kaps and mbtiles, with which transparency. 

More about charts 

NMEA Connections 

qtVlm can connect to a lot of various NMEA sources (serial port, internal GPS, GPSD, TCP, UDP, file 

replay, B&G WebSocket, etc.). Several sources can be used simultaneously. 

NMEA 2000 is not supported, a convertor must be added. 

Most NMEA messages are implemented and are used to feed instruments and/or AIS module. 

 

More about NMEA connections  
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AIS Module 

qtVlm allows to display and manage AIS targets received through NMEA sources. It can calculate a CPA 

and a TCPA and manages configurable alarms. 

 

 

A simulation mode is proposed in qtVlm, through a collaboration with sinagot.net and AisHub.com. It 

receives real AIS targets via Internet, and allows to simulate sailing between them, using gribs data and 

polar to move the boat. This mode is accessible via the menu “Boat->Simulation mode”. 

Besides Simulation Mode, these internet AIS targets are also available in Real Mode. 

ARPA targets (radar) are also supported. 

More about AIS module  



16 
 

Instruments and Board 

Most of classical instruments are available in qtVlm. They appear at the bottom of the screen or on the 

left side, depending on the screen orientation. They can be hidden or shown with the toolbar instrument 

button . An independent panel can also be displayed through the  icon. 

Dials can be shown and hidden by clicking on the numerical displays. Use long click to display histograms. 

Instruments sizes and positions can be easily changed, and It is possible to select which instruments are 

displayed. 

 

 

More about instruments and dashboard 
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Weather Routing Module 

The main qtVlm function is the ability of calculating routings and routes, based on grib data and boat’s 

polar. 

Once one or several gribs and a polar have been loaded, a routing can be very easily generated, for 

instance by right-clicking on a POI or anywhere on the map. 

 

It is also possible to ask for a multi-routing, in which case qtVlm will generate several routings to 

determine the best starting date and time, based on numerous factors. 

  

The result of the multi-routing calculation is displayed in a Routes Comparator, which can be exported in 

CSV format. Columns can be hidden of shown. 

 

Pathways can also be used as targets for routing, in which case the routing will follow a path, going to 

each point in turn.  
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Once the routing calculation is terminated, it is possible to convert it in a Route, and then optionally to 

simplify and optimize the resulting route. This can be done automatically if the option “convert to route” 

is checked before launching the routing calculation. 

 

Many other options are available, like for instance asking for pivot points, calculating inversed isochrones, 

placing barriers, multi-points routing, etc. 

More about Weather Routing Module  
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Routes Module 

Route in qtVlm allows several navigation modes between POIs (vbvmb, vmg or Great Circle). It can also 

display and export in CSV format the route’s log containing many information.  

 

 

More on Routes Module  



20 
 

POIs and Barriers 

POIs (Point of Interest) are point that can be placed in qtVlm. They can be used for a variety of tasks, like 

start or arrival points for routes or routings. They can also be defined as the active boat’s WP, and as such 

be sent on NMEA output. 

Laylines can also be displayed (from grib or NMEA data). Currents are considered. 

 

It is also possible to create barriers, that will be avoided by Routings and Routes modules. 

 

More about POIs and barriers 
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Start Line Mode 

This mode can be activated from “boat” menu. It manages a race chronometer with two configurable 

tops and displays time and distance to line. A safety zone can also be displayed over the start line. 

 

Currents and boat dimensions are taken into account. 

More about Start Line Mode  
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Mobiles Versions (Android and iOS)  

Android and iOS versions are available on Google Play Store or Apple Store. While PCs versions are 100% 

free, the full version must be purchased to benefit from all the functionalities. Once activated, the full 

version is available for all your devices for this operating system, which means that an Android license 

works on all your Android devices, and an iOS license works on all your iOS devices). 

The full version activation adds: 

• Routes and Routings modules, Rasters, S57, S63, CM93 and Mbtiles modules. 

• Instruments and AIS modules. 

• Support of Harmonics files (Tides and Currents). 

• Iridium grib requests, and Great Circle (Squid) grib download or requests. 

qtVlm on mobiles is designed to be used together with the PC versions. It is possible to load gribs, maps 

and so on, to prepare routes and routings on PC and then transfer all to Android or iOS devices. 

To achieve this, on the PC side just go to qtVlm->export, then copy the resulting zip file on the mobile 

device (on iOS this can be done for instance via iTunes or AirDrop) and run the import function. 

Depending on which options were used, the mobile device will then be in the same configuration, with 

the same maps, routes, gribs, polars, etc. 

Mobiles versions are also of course useable without PC at all. All the functions described in this document 

are available on Android and iOS versions. 

 

 

 

Google Play Store  Apple Store 

https://play.google.com/store/apps/details?id=org.meltemus.qtvlm/
https://itunes.apple.com/br/app/qtvlm/id999110023?l=en&mt=8/
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File management on mobile versions  

Android 

On Android a PC file manager can be used to manage directly qtVlm files. There is a qtVlm folder at the 

root of your internal card, where you can find all sub-folders like gribs, kaps, S57, mbtiles, etc. Please note 

that most of these folders (including gshhs maps) can eventually be transferred on an external SD-Card. 

In that case it is better to use qtVlm’s dedicated folder: /Card/Android/data/org.meltemus.qtvlm/files. For 

each main category, there are options in qtVlm configuration screen to indicate where to locate the files. 

Attention: For devices running Android 11 or more, qtVlm files are now located in: 

/Android/Data/org.meltemus.qtvlm/files 

If you cannot access this folder via the regular Android Files Manager, it is recommended to install a 

stronger Files Manager, for instance “Files”, free and available on Google Store. 

Importing files like polars, gribs etc. can be done by pressing long on the file in a File Manager, and then 

choose “open With’ (or “Share with” in some cases), and choose qtVlm 

To import charts (mbtiles, Rasters, ENCs, etc.), put them in a zip file and again open this zip file with 

qtVlm. 

iOS 

On iOS file transfers can be made in several ways. 

Most file extensions are declared into iOS for qtVlm, so it is possible to open an email attachment and 

send it directly to qtVlm. 

For users equipped with a Mac, it is also very easy to transfer gribs, polar, charts, etc. using Airdrop. 

It is also possible to transfer files via iTunes. Connect your device on a PC, launch iTunes, and click on the 

small icon representing your device. 
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Then click on “File sharing”: 

 

And finally choose qtVlm as an application: 
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You can now drag and drop files in this folder. For instance, let’s imagine you want to transfer “Visit My 

Harbour” charts to your iOS device. Just select them from the dongle or the DVD and drop them into 

iTunes: 

 

Then you can launch qtVlm, or if it is already running launch “qtVlm->import from iTunes folder” in order 

to integrate these files into qtVlm. In the case of VMH charts, you will also have to activate them using 

qtVlm->Configuration->Charts and choose “VMH activation”. 

Please note that although sub directories in this folder cannot be opened directly in iTunes, you can drag 

and drop them on your PC, do whatever you need to do (copy, delete files), and then drag it back into 

iTunes. 

You can also transfer files using Finder on a Mac. For this you need to open 2 Finder windows, one of 

them showing your connected device and the “files” tab, which should have a line for qtVlm. Then from 

the other finder windows you can just drop the file into qtVlm and then run “Import from iTunes folder” 

in qtVlm. 

Exporting files on iOS, sending as an email attachment 

In qtVlm there are many possibilities to export files, for instance export a route as a gpx file, or a route’s 

log as a csv file, etc. 

In Configuration->General there is an option “Automatically open exported files”. When this is on, iOS 

will prompt you with a list a compatible apps and some actions. There is no possibility there to choose 

“send an email” but you can choose “Save to Files” and then from Files application open the exported 

document, choose “Share” and finally send an email with the exported file as an attachment. 
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Polars and boat ’s behavior parameters  

Wind Polar 

From the menu “Boat->Boat settings”, you can select a polar: 

 

To import a custom polar, you can either copy the polar file into qtVlm polar folder or use the button 

“import a polar”. 

You can also request a polar from our server (internet connection required). More than 250 polars 

available and growing. 

Another good source for polars: http://jieter.github.io/orc-data/site/ 

You can apply efficiency factors (different for upwind and downwind), and specify a polar efficiency factor 

during night periods, and you can choose to force best wind angles values, or to let qtVlm calculate them. 

  

http://jieter.github.io/orc-data/site/
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Sails parameters  

You can specify sails configurations for ranges of TWS/TWA. This information will be shown in various 

Route Module places, such as Route’s logbook, Route’s tooltip and Route’s statistics. There is also an 

instrument available that will display the current optimum configuration: 

 

Data for this is provided in the form of a sails polar, divided in two files: 
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The first file affects a number to each sail’s configuration. Its extension must be “.saildesc”. 

 

The second file (extension sailselect) defines the utilization of each sail’s definition according to 

TWS/TWA: 

 

In both cases separation is the semi-column. These files must be placed In the “polar” directory. 
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Waves, Gusts and Ice Density parameters 
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Waves 

Boat’s behavior in waves can be defined in two ways: 

• You can specify a “Waves Polar”, that will indicate what gain or loss will be calculated depending 

on waves angle and height, i.e., which % to apply on the wind polar. Waves Polar can be defined 

for various TWS, because for instance 1m waves height has more effect in very light winds than 

in strong winds. Waves polars can be displayed graphically through the “boat” menu. Please see 

Waves polar format for a detailed explanation concerning the format of a “Wave Polar” and 

explanations concerning waves steepness. 

For this calculation, qtVlm uses these data, sorted by priority: 

1. Primary Waves Direction and Combined Waves Height 

2. Wind Waves Direction and Wind Waves Height 

3. Swell Direction and Swell Height 

4. Mean Waves Direction and Combined Waves Height 

5. Max Waves Direction and Max Waves Height 

6. Wind Waves direction and Combined Waves Height 

7. Wind direction and Combined Waves Height 

• Crossed Sea: You can define what is crossed sea by entering a minimum height and a minimum 

angle between wind waves and swell. If wind waves direction is not available (as often), then 

wind’s direction will be used instead. If such a condition is met, a coefficient will be applied on 

the wind polar. Grib data used are Swell Height and Direction, and Wind Waves Direction. 

Gusts 

In case Gusts data is present in the gribs, you may configure how Routings and Routes module should 

adjust the polar. In normal cases when gusts are strong compared to average wind the boat may navigate 

under-canvassed so the polar needs to be adjusted. 

You can also increase the polar by inputting a polar efficiency over 100 %. 

 

Note that there is also a parameter in routings to avoid places where gusts are over a value. 
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Ice density 

 

The maximum ice density is used by routes and routings modules. It is the value for which the speed of 

the boat will fall to 0. Between 0% and this maximum, qtVlm will interpolate a speed using this formula: 

Boat Speed = Polar Speed * (1 – Actual Density / Maximum Density). 

So for instance for a maximum density of 20%, with an actual density of 10% the boat speed will be 50% 

of the polar speed. For a 5% ice density it will be 25%. 
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Engine and penalties for Gybes and Tacks  

 

You can specify that when the boat’s speed with sails is under a value, the engine is started, with a boat’s 

speed in that case that will override the polar value. Note that if any waves parameter is setup, the 

engine’s speed will be affected by these parameters. 

You can also specify parameters for tacking/gybbing (speed loss and duration). Units are expressed in 

“Cranks”, which is qtVlm internal calculation step (by default 5 minutes). During that duration, route and 

routing will not be allowed to tack or gybe again. 
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Wind Polar Formats 

CSV format 

CSV is the most used format. You can edit it in a spreadsheet. 

 

 

It must start with TWA/TWS or TWA\TWS. 

It is basically a simple text file, with fields separated by a semi-column. The decimal separator is the point. 

 

The 1st line contains wind speeds in knots. It has to be real wind TWS and not apparent wind). The 1st 

column contains wind angles (TWA). The table is then filled with a value in each cell that will indicate the 

boat’s speed for that couple TWS/TWA. The steps between TWAs and TWs is free of constraints, but each 

cell must have a value. 

POL format 

It is the same as CSV format, except that the separator between field is the <tab> character. 

XML format 

It the format used by Maxsea. It comes as an XML file. 
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Waves polar format and waves steepness  

Wave polar format 

Waves polars must have an extension “.polwave.csv”. Since it is a csv file, it can be loaded in as a 

spreadsheet. 

 

Wave Polars can be defined for various TWS. If only one TWS is defined this wave polar will be used 

regardless of the actual TWS. 

The first cell indicates for which TWS this polar is meant to apply. Data in abscise represent Waves height 

in meters, and data in ordinate represent angle between waves and boat heading. 

Data is the percentage to be applied in that case. In the example above, 103% of the polar speed will be 

used if TWS=10, Wave Height is 2 meters and angle between wave and boat is 120°.  

qtVlm will interpolate any intermediate values. 
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Waves steepness 

Wave steepness is defined by the formula “Wave Height divided by Wavelength”, wave height being the 

vertical distance between crest and trough and wavelength being the horizontal distance between two 

crests. 

You can choose to inject Wave Steepness into wave polar calculations: 

 

For this you need to define 2 values, wave steepness reference and wave steepness low limit. 

The wave steepness reference is the “normal” steepness for which the wave polar has been defined. The 

usual value is 3% which is the average steepness in deep waters. Note that over 14% the wave is breaking. 

The steepness low limit is the value under which the wave polar will not be applied at all. 

For any wave steepness over the low limit, qtVlm will interpolate (or extrapolate) a percentage (low limit 

being at 0% and reference being at 100%), and this percentage will be applied to the wave polar 

coefficient. 

For instance, with limit = 1% and reference = 3%: 

If the wave polar returns 85% (a penalty) and the wave steepness is 2%, qtVlm will apply only half that 

penalty, i.e. 92.5%. 

Similarly, if wave polar returns 110% (a bonus), and wave steepness is 4%, the resulting coefficient will 

become 115% (more bonus). 

To be able to calculate wave steepness the grib must contain wave height and wave period. 

The order of priority is: 

1. Combined Waves Height + Primary waves Period 

2. Wind Waves Height and Wind Waves Period 

3. Swell Height and Swell Period 
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Viewing Polar 

Studying polar 

This function is located under the menu “Boat->Wind Polar analysis”. 

 

This dialog shows critical angles for the polar (best VMGs). Note that it is possible to modify the polar 

outside qtVlm in the same time. Just press “Reload polar” each time you save it. 

Editing polar  

The polar (csv or pol) can also be edited via the menu “Boat->Wind Polar Editor”. 
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Showing polar in the main dashboard  

Polar can also be displayed in the main board. If wind data is available from NMEA sources, the polar will 

adjust itself automatically to current TWS, allowing to compare theoretical polar speed with actual one. 

 

Showing polar on the map 

Polar can also be displayed directly on the map. For this go to the menu “View->show/hide and check the 

line “show/hide speed polar” (or press “Ctrl+L” ). The polar will use the wind from the gribs, or the wind 

from instruments if NMEA is running and has TWS/TWD and the polar is centered on the boat. 
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Magnetic Variation  

Magnetic variation is defined in the last tab of boat’s settings: 

 

Instruments will use this data is (M) mode is selected. You can either use a forced value or get the 

magnetic variation from NMEA message (RMC), or from WMM (World Magnetic Model). 

Variation retrieved via WMM can also be shown in a route’s logbook, and in the “Query grib data” dialog, 

at any point. 

Querying magnetic data at any point/date  

For any point you can access World Magnetic Model data via contextual menu (right-click or pinpoint) 

  



40 
 

Environment 

General settings 

From the main configuration dialog, you can choose the language, select the units for distance, the 

format and zone for the time and date, and many other details. You can also choose the default font and 

size for various elements. 

 

 

OpenGL option is recommended if you intent to use course-up mode. 

The Extended View switch allows qtVlm to draw in advance charts outside of the screen, which will 

improve panning but is rather resources intensive and will slow down a bit the rendering. 
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Earth radius 

In “Advanced” section, you can choose between “Average” or “Celestial” Earth radius 

 

Average uses the average radius of the WGS84 ellipsoid (6,371 nm)—it yields the more accurate values 

for range and bearing between distant points on the earth.  

Celestial uses a spherical earth with 1’ of latitude = 1 nautical mile (6,366.707 nm)—it yields accurate 

intersections of circles of equal altitude centered on the geographical position of celestial bodies. It will 

also match traditional computations of great circle distances between distant points.  
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Menu 

qtVlm menu consists in several sub-menus: 

QtVlm Menu 

 

This menu contains the Quit command to close qtVlm (with or without saving data). It also allows to 

switch from VLM mode to Real mode or vice versa. 

It also contains the Export and Import functions, that allows to transfer all or some data from one qtVlm 

installation to another (PC or mobile). 

It also contains the Configuration function, with all qtVlm settings. 

The license management is used to associate a device to a S63 permits, a Windows tablet license and 

Meltemus charts packs. 
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View menu 

 

This menu is managing the display status of qtVlm items (POIs, traces, routes, etc.). 

You can also change light mode to Night or Dusk. 
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Charts menu 

 

This menu is dedicated to charts functions. From there you can select charts groups and ENC display 

category. 

You can also Search for objects in ENCs charts, and open/manage various chart catalogs. 

There is also a function to display your boat and trace on Google Earth. 

AVURNAV manages Warning and Notices from French authorities. 

The shapefile sub-menu allows you to open shapefiles coming from SHOM or from other sources. 
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Data menu 

 

This menu manages gribs and other weather or maritime data. Three slots are available, where you can 

load gribs from different sources, containing different data or resolutions.  

Various types of downloads are available. It is also possible to merge gribs, for instance to build a single 

grib containing Winds, Currents and Waves. 

SHOM thumbnails displays tide previsions and oceanograms. 

You can also ask for particles, or 3D pressure view.  
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Boat menu 

 

This menu manages access to boat settings, where you can for instance specify which polar you want to 

use. It can also launch the “Simulation Mode”, and you can define several types of sound alarms. 

It is also from there that “Start Line mode” can be activated. 

AIS targets list and AIS fleet instrument are also available from this menu. 
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Boat settings 

 

This configuration screen defines various boat parameters, especially concerning wind polar, parameters 

depending on sea state, engine usage, etc. See Polars and boat behavior for more info on these settings. 

It also allows you to set the size of the boat icon displayed on the map. A zero size will display a simple 

point and the name of the boat. 

Two images can be defined: one to replace the default “Imoca” icon, and one that will be used at high 

zoom level to draw the boat in real size dimension. 
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The GPS antenna placement on the boat is defined, so the physical size of the boat and AIS targets can 

be taken into consideration when calculating CPA and TCPA (closest point of approach in AIS module), 

and in Start Line Mode. Draught is not used for the time being. 

If dimensions are defined, qtVlm will render the boat using a shape or the image defined for that in the 

first tab, when the zoom level is high enough to draw 5 mm on the screen. 

Icon and real boat images are always rotated with CTW, or COG if CTW is not available. 

Own MMSI can be input, in which case messages coming from this MMSI will be ignored by AIS module. 

 

You can draw one or several circles centered on the boat. 
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Magnetic variation can be either forced, taken from NMEA message, or taken from World Magnetic 

Model (WMM). 
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Some other options concerning the boat are also available in the main configuration screen, tab “Boat 

and Instruments”. 

 

Apart from various reckoning and trace options, you can specify here what Crank duration qtVlm will use. 

This is the internal step qtVlm is using for all calculations. A small value gives more precise results, but 

will be costlier in CPU, memory, and computation times. 

From the boat’s contextual menu, you can lock the boat’s position on the screen. The boat will then stays 

are the same screen position and the chart will be moving. This is canceled as soon as the chart view is 

changed (zoom, panning, etc). 
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Routings menu 

 

This menu manages routing (creation, edition, deletion). Note that unlike routes, routing are not saved 

when you close qtVlm, and there is no import/export functions. Routings are meant to be converted in 

Routes. 

Routes menu 

 

This menu manages routes: creation, deletion, edition, import, export, and comparing. 

Pathways menu 

 

This menu manages pathways, which can be used for multipoint weather routing. A pathway can also be 

activated. More information on that in Pathways module  
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Barriers menu 

 

This menu manages barriers. Barriers are meant to materialize no-sail-zones or other forbidden areas. 

They are avoided by the routing calculations. 

Marks menu 

 

This menu manages POIs (Point of Interests). It also allows importing marks from other sources. 
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Help menu 

 

This menu allows access to various help resources. It also contains the list of recent modifications in 

qtVlm. 
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Shortcuts 

 

Alt+A   Alarms management. 

Alt+B   Center map on boat. 

Alt+C   Show/hide compass. 

Alt+E   Show/hide labels. 

Alt+F   Show/hide boats flags (VLM mode). 

Alt+H   Unlock moving and resizing gauges and histograms on map. 

Alt+I   Show/hide Instruments on map. 

Alt+K   Close single chart. 

Alt+L   Show/hide polar. 

Alt+O   Show/hide opponents (VLM mode). 

Alt+Q   Show/hide magnifier. 

Alt+R   Create a routing. 

Alt+S   Simulation mode 

Alt+T   Show/hide tracks. 

Alt+X    Configuration. 

Alt+W   Open a weather image 

Alt+Z   Keep boat’s screen position when zooming. 

Ctrl+B   Start a batch. 

Ctrl+D   Race data (DCC) 

Ctrl+E    Take a screenshot. 

Ctrl+F   Open Search Vector Charts dialog 

Ctrl+G   Grib display configuration. 

Ctrl+H   Open/close balisage SHOM. 

Ctrl+I   Gribs information. 

Ctrl+K   Open a single chart. 

Ctrl+L   Show/hide lights sectors on vector charts. 

Ctrl+M  POIs management. 

Ctrl+O   Open a grib. 

Ctrl+Q   Quit qtVlm. 

Ctrl+P   Add a POI 

Ctrl+R   Reload POIs and routes. 

Ctrl+S   Save POIs and routes. 

Ctrl+V   Paste a route. 

Ctrl+W  Close all gribs. 

Ctrl+Alt+A  Vector Charts All display mode. 

Ctrl+Alt+B  Vector Charts Base display mode. 

Ctrl+Alt+C  Vector Charts Custom display mode. 

Ctrl+Alt+D  Vector Charts Detailed display mode. 

Ctrl+Alt+G  Show in Google Earth. 

Ctrl+Alt+H  Unlock moving and resizing LCDs on map. 

Ctrl+Alt+I  Information about vector or raster chart at cursor position 

Ctrl+Alt+L  Show lights visible from boat (vector charts only). 

Ctrl+Alt+O  Show/hide charts outlines. 

Ctrl+Alt+P  Vector charts elements at cursor position 
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Ctrl+Alt+S  Vector Charts Standard display mode. 

Ctrl+Alt+T  Show/hide main board. 

Ctrl+Alt+V  Raster and Vector charts configuration. 

Ctrl+Alt+W  Show Alarms history 

F1   Documentation. 

F5    Sync boat (VLM mode). 

Ctrl F9 to F12 Store screen zoom level and position. Any single chart displayed will be 

saved as well. 

F9 to F12 Restore screen zoom level and position and eventually redisplay the saved 

chart. 

 

Also note that when moving a POI, you can press <Shift> before dropping it and it will return to 

its initial position. 

Zooming with mouse wheel can be altered with CTRL (zoom at mouse position even if the 

option “keep boat position on screen while zooming” is active), SHIFT (slow zoom) and ALT 

(fast zoom). 
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Toolbar 

The toolbar consists in various icons, grouped by themes. 

You can choose which icons are displayed in the General settings tab (or the toolbar tab on mobile 

versions). 

 

 

 

Show/hide toolbar icon  

 

This icon will hide the toolbar, useful on small devices to recover some screen space. When the toolbar is 

hidden a single icon will appear on the chart, allowing to restore it 
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Maps and Instruments icons 

       These icons activate or deactivate Online maps, Raster maps (Kaps, Geotifs, 

etc.), Mbtiles maps, Vector (S57/S63) maps and CM93 maps. Mbtiles icon has 3 states and can be used to 

lock tiles level at current value. 

   This icon materializes lights visible from the boats and is available with vector charts only. It has 3 

states, lights on, lights from boat and lights off. 

 

 This icon switches the display between “North Up” and “Course Up” mode. It is recommended to 

activate openGL display in the main configuration screen if you intent to use “Course Up” mode. 

      The first two icons hide or show instruments on map or in panel. The third 

one hides or displays the main dashboard. The fourth one activates or deactivates AIS reception, the fifth 

one shows/hides AIS Fleet instrument, and the last one activates/deactivates VDR recording. 

This icon has 3 states and switches the light mode to Day, Dusk and Night light mode.  

 These four icons are used for zooming the view. You can also use mouse and mouse 

wheel (or fingers on mobile versions) for that. Note than on Android, + and – buttons are replaced with 

volume+ and volume– physical buttons. 

 This icon is used to switch to selection mode. It allows to select an area on the map, or a group of 

POIs for instance. The same action can be achieved with the mouse together with <shift> key (with <ctrl> 

key it will zoom on the selected area). 

  This icon activates/deactivates the magnifier. 



59 
 

 This icon shows/hide the compass on the map. Please note that the compass can eventually 

rotate if the device is equipped with a magnetometer sensor. The size of the compass can be changed in 

the general settings. The center part of the compass is oriented according to wind direction from grib, or 

from real data if it is centered on the boat and these data are available. 

 

Tides and Currents icons 

 These two icons allow you to show or hide tides and currents from tides (Harmonics) on the 

chart. 

Grib icons 

 

 Press long on this icon to get a sub-menu managing various grib download commands. 

  This icon will open a grib in the first slot. 

  This icon manages grib display configuration 

 This icon selects which grib slot (or all) is activated. 
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 This icon hides or shows grib data on map. 

  This icon allows to choose a date in the gribs. 

 This icon sets the grib’s date to now. 

 These icons are used to move the grib’s date forward or backward, according to the defined 

step. 

 This icon launches the grib animation. 

Boat icons 

 These icons are used to define the unit and the length for boat’s 

reckoning line. 

 This icon is used to defined or stop alarms. It appears in green if no alarm is currently triggered, and 

in blue if all alarms are muted. 

Barriers icons 

 This icon can be used to place barriers on the map, that will be avoided by Routings and Routes 

modules. 
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Goto icon 

 This icon drops an active WP in one click on the map. You can also configure it to generate 

automatically a route and activate it. 

 

Man Overboard icon 

 This icon creates a mark with the same symbol at boat position. This mark becomes 

automatically the active WP, and some information related to it (time since dropped, heading, distance) 

are displayed in the alarm module.  
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Map and main objects  

 

POIs (points of interest) can be placed on the map with a right-click on the map (or with pinpoint icon 

 on mobile versions). POIs can be moved with the mouse, or by capturing new coordinates in their 

editor. 

The boat can also be moved with the mouse, or by right clicking the map and selecting “move boat here”, 

if GPS reception is not activated. 

You can also display a longitude/latitude grid over the map. 

Status bar 

 

It contains information from grib data at the mouse position. It can also show other information like 

distances, coordinates, or running imports. The font size can be specified in the main parameters. 

Please note that only data actually shown on the map are displayed in the status bar (i.e. if you have for 

instance Currents in one grib but this data is not displayed on the map then the value of Currents at cursor 

position will not be displayed in the status bar. 

The right side of the status bar is dedicated to active WP relative data.  
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Ruler tool 

From all objects and directly on the map, the function “Ruler tool” can be called, through the contextual 

menu (or with the pinpoint on mobile versions). 

 

This function shows Great Circle and Rhumb Line lines with distances, angles, etc. It will turn red or 

orange if crossing an obstacle or a danger. TWA data is also displayed, based on grib and instruments 

data. 

Note that several legs can be used, by double tap or click on the screen. 

Another way of getting a ruler tool is to use the function Line between POIs , or a pathway if you 

want to be able to move points. 

Draw a grib reckoning 

From all objects and directly on the map, the function “draw a grib reckoning” can be called, through the 

contextual menu (or with the pinpoint on mobile versions). 

This function calculates the boat’s 

position based on polar and grib 

Winds data. Five legs can be defined, 

either in fix TWA or fix heading 

mode. Penalties for tack/gybes, and 

waves parameters are not taken in 

account. 
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Reckoning 

Several types of reckoning are available. The choice is made either in the main configuration dialog 

(boat tab), or from the boat’s contextual menu (right-click). The reckoning length can be specified in 

number of cranks, duration or distance. Reckoning line flashes if it crosses a land. 

• Reckoning based on boat’s speed and heading: this is the projection of the instantaneous boat’s 

speed and heading. No grib data is used for the calculation. This is based on COG and SOG. 

Please note that the boat’s icon orientation is based on CTW, if available. 

• Reckoning based on boat’s TWA: this reckoning assumes boat’s TWA will remain the same and 

is calculated using grib data and polar. Currents grib data is taken into consideration if present. 

• Reckoning based on boat’s HDG: this reckoning assumes boat’s heading will remain the same 

and is calculated using grib data and polar. Currents grib data is taken into consideration if 

present. 

• Cone reckoning: This will display a Cone in front of the boat, capable of detecting dangerous 

objects. 

• Vector reckoning: This is the same as the Cone reckoning, but it displays a rectangle instead of 

a cone. 

Please see Danger detection chapter for more details. 
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Internet via Iridium GO! 

qtVlm can manage and handle Iridium GO! device to launch an internet connection and monitor its status. 

This connection can be use for the following items: 

• Direct download of grib files from xyGrib and Squid, 

• Email grib requests via Saildocs, 

• Download of race data positions (positions reports in DCC format), 

• Download of satellite data (TLE) for Iridium satellites constellation, 

• Download of weather stations, 

• Download of weather images. 

This is compatible on all qtVlm supported platforms. 

For the connection to be active, you must be connected on Iridium WIFI network, and you need to specify 

Iridium GO! mode in qtVlm internet settings: 

 

You can eventually modify Iridium parameters if you have changed default user and password and/or 

URL. 
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When an Iridium GO! download will occur, the following screen will appear: 

  

You can press the minimize button that will show an Iridium button, green if all goes well or red if there 

is an issue or an error. Pressing this button will restore the normal Iridium GO! window. You can 

continue normal activities in qtVlm during the download. 

It shows: 

• the current status, 

• the number of retries, 

• the last error if any, 

• the current task name (type of download), 

• the connection status, 

• the signal strength, 

• battery level and battery loading status. 

qtVlm will start the download when the signal strength is >= 3. Download resumes are handled. 

Also note that you can check Iridium satellites elevations and bearings at your location from the main 

dashboard, “Satellites constellations” tab. 
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Licenses Management –  MELTEMUS charts packs  

From qtVlm menu, you can access your licenses and manage them. 

 

There are 3 types of licenses: S63 permit, Windows Tablet license and Meltemus Charts Packs licenses. 

From this screen you can for instance install or reinstall a charts pack or update it. 

Charts packs are renewable directly from this screen. Expired licenses appear in red, renewed licenses 

will be green. 

By default, you receive a notification via email whenever a charts pack needs to be updated. You can 

disable this notification from this screen. 

Charts pack updates are also made from this screen. Just select the pack (which will be in italic if it needs 

to be updated) and click on “Update charts pack”. 

Note that this is NOT intended to manage Android or iOS full version licenses, which are handled 

directly by the relevant store.  
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Tracks Module 

By default, qtVlm records your track when your boat is moving. To keep the number of points minimal, 

it removes useless points (aligned, too close from previous one), based on Track settings available in 

Configuration dialog, Boat tab: 

 

The maximum track’s length is also defined there. Width and color are chosen also in this tab. You can 

hide track from the View menu. 

Track management is handled in boat’s menu: 
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Tracks can be exported in KML, GPX or CSV format, depending on the extension chosen for the output 

file. You can also import a track if in GPX format. 

 

When starting a new track, you will be asked if you want to archive the current track. 

Tracks when anchored use a high-definition scheme and store a maximum number of points. 

Optionally, you can show tooltips for each track’s points. 
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Voyage Data Recorder (VDR) 

From the Boat menu, you can select “Voyage Data Recorder”: 

 

This recorder will store boat data at regular interval. 

Data recorded is Position, COG, SOG, TWS, TWD, TWA, CTW, STW, PRE, XTE, RPM, GWD, GWS and 

Active Alarms. 

Once started, VDR will automatically run when NMEA or Simulation mode is active. On Android and iOS 

the recording is paused when the application is in background. 

VDR can be started/stopped in one click from the toolbar.  
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VDR settings 

Various parameters are available in the settings tab: 

 

You can set the time interval for the recording. Minimum value is 10 seconds. Recommended value is 1 

minute. 

You can also add some more events that will trigger a VDR update: 

• A change in COG more than n degrees, 

• A tack or a Gybe, 

• A new alarm event. 

You can also choose to hide some columns. Data is collected even if a column is hidden. 
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Adding Observation and/or images to a VDR line  

You can double click on a line to insert a comment or an image. 

 

 

Note that images are stored as images and not as link to a file, meaning that once inside the VDR you can 

delete the original image file. 
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VDR actions 

Besides Start or Stop recording, various actions are available: 

 

• Clear will empty the VDR completely (and even delete the file if this is not the default VDR file 

called “vdr.db”). 

• Save as allows you to create a copy of the loaded VDR 

• Create a track will convert the VDR in a track that you can later find in Archived Tracks. 

• Export will export the VDR in a CSV files. Images are not included. 

Saved VDRs can be viewed and manipulated from the “Saved VDRs” tab. 

Comparing recording data with loaded gribs  

Via the third tab of the VDR dialog, you can compare either recorded wind speed or wind direction with 

grib data. This is useful for analyzing which grib was better during a race, for instance. Note that 

Ensemble and ASCAT gribs are not supported in that comparison. 

Recorded wind speed will eventually be adjusted to 10 meters height, using the “Wind instruments 

altitude” parameter in the settings tab. 

 

As in meteogram, you can right-click on the graph to see values for all lines or select a rectangle to zoom 

in (double click or press Escape to exit zoom mode).  
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Alarms Module 

 

Each alarm is associated with a sound and some conditions. AIS alarms and Anchor alarms conditions are 

defined in their respective modules, but you can define the sound played from this dialog, for instance: 
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Several alarms can be defined at the same time, in which case qtVlm will generate a playlist with all the 

sounds. Some alarms have a delay parameter, to specify that you want the alarm to ring only if the limit 

is exceeded for more than that time. If the defined limit is exceeded by more than 1.5 times, the alarm 

will be triggered regardless of the timer. 

For instance: 

 

Regarding the alarm on distance to coasts, only the coastlines and eventually the dangers issued 

from vector charts that are in the area covered by the screen are taken into consideration.  

Alarm on Atmospheric Pressure is available only if the relative instrument and histogram are configured 

in Instrument’s settings. 

The Radio Communication alarm will be triggered if the boat is entering a compulsory communication 

area (COMARE) or will be within a configurable distance to a compulsory Radio Point (RDOCAL or 

NOTMRK category 37). 

See Danger detection chapter for more details on this alarm. 

The main tab can be used to completely stop all alarm, or to mute all sounds. Blue icon means that the 

alarm is not configured, green icon means that the alarm is configured but not triggered, and red icon 

means that the alarm is activated. 
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When one or several alarms are activated, a box showing which alarms are triggered is shown on the 

screen. By pressing on this box, sound alarms are muted for 10 minutes. 

Note that Laylines Alarm is only triggered if the POI with laylines is the active WP. 
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Tides and Currents from Harmonic files  

Data for Tides and Currents can be calculated from Harmonics files (ASCII or binary). This calculation is 

an estimation that do not replace real bulletins from local authorities. 

To be able to display Tides and Currents from Harmonic files (which we do not provide), you need to 

define where these files are located. This is done via the Parameters dialog, “Grib and Harmonic” tab: 

 

On iOS or Android, these files must be put in a zip file named “harmonic.zip” and send it to qtVlm via 

the usual way (airdrop, email, iTunes, etc.). 

Since some Currents stations are collocated (with different depths), you can choose to show the Currents 

arrow only for the shallower station. 

Once the files have been installed, you can display Tides and/or Currents via the toolbar 

icons or via the “Data” menu. 

Please note that Currents information is just visual, routings and routes modules will not use them 

and need a grib with Currents data to be able to integrate Currents in their calculations.  
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The information displayed on the chart depends on the zoom level. At large zoom levels, the information 

is presented with small icons indicating that Tides or Current information exists at that location. 

 

Once the zoom level is detailed enough, the information is presented in this form: 
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The date used for calculating tides and currents date is the grib date, so you can 

use grib date icons or slider to move it or even animate it. The date can be set 

before the grib’s starting date or after the grib’s end date. 

Tides symbols (rising tide, high water, ebb tide, low water) evolve like this:  

       

Several display options are available: 

 

Tides and Currents objects can be queried via their contextual menu. Collocated stations can be selected 

from the combo box on the left. 
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Note that you can choose to display the station data in UTC time, local machine time, or station time 

zone. The yellow bar represents daylight and twilight. 

Tides: 

 

Currents: 
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SHOM thumbnails  

This function is available from the Data menu. It will display on the chart spots where a SHOM thumbnail 

exists. It consists in either small or big thumbnails with tide information at that location: 

 

For instance, here is a small thumbnail: 

  

Note that all times (except for France) are expressed in local time zone WITHOUT summertime 

correction. 
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In France, you have also the possibility to display an oceanogram with various data: 
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Gribs and Weather Images 

Gribs 

qtVlm can use gribs from many sources, in format 1 or 2, compressed or not. Three slots are available for 

that, so it can manage three gribs simultaneously, containing different data or different resolution for 

the same data. If a grib contains the same data at different resolution, the data with the best resolution 

is used for calculations and display (if both gribs have the same resolution, the lesser grib slot number 

will be used. qtVlm will switch to the bigger resolution only when the data with the best resolution is 

exhausted in time or area. You can also force the usage of a single grib slot from the toolbar or from the 

grib display settings dialog. 

 

In practice, it is usual for instance to load a grib with Winds data in the slot 1, and a grib with Currents 

data in slot 2, but in fact the slots are equivalent, and the order does not matter. 
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Gribs general options 

 

This configuration screen is available via the menu “qtVlm->configuration”, Grib tab. 

The folder used to store downloaded gribs can be specified. Beware that by default, all gribs in qtVlm 

default folder will be deleted if they are older than 3 days. If another folder is specified this cleaning 

process will not apply. 

It is also possible to filter out irrelevant data and keep only useful data used by Routes and Routings 

modules. This is useful to limit memory usage and therefore be able to load bigger gribs. 

The first option relates to Saildocs, a service that can send you gribs via email. You can choose if you 

want to see Saildocs options screen when you generate a request, or use last settings used. 

Depending on which platform you are running qtVlm, you can also generate requests via Iridium GO!. In 

this case you must indicate the relevant account information for XGate and/or Iridium Mail and Web. 

You can also use directly Iridium GO! connection to download grib files (Saildocs or Xygrib). For this you 

need to activate Iridium GO! mode in qtVlm internet settings. 

Check “use an external mail client” in “E-Mail and Internet” tab is you are using for instance Outlook. 

You can also specify custom addresses (URLs) for downloading gribs. 

You can also access directly to your Squid gribs subscriptions. In this case you must indicate your Great 

Circle account information.  
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Xygrib download 

You can also request directly a Xygrib (OpenSkiron) download, after selecting a zone on the map. Several 

models are available. 
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Saildocs download 

Select a zone on the map, then use its contextual menu to request a Saildocs grib. If the relevant option 

is checked in the general grib settings, you can select which kind of model, data, duration, etc. you want 

to request. 

 

You can choose how the mail is going to be send, from the internet tab in qtVlm configuration dialog. 

 

Please note that if you choose “Through qtVlm email server” the email will be sent directly without the 

need to open your email client application. This option is compatible with Iridium GO! mode. 

Some explanations on the different grib models available here: grib models 

Several mails can be received if several models are selected. 

  

http://www.saildocs.com/gribmodels
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If the usage of an external client for email is unchecked in the options, you will need to copy/paste the 

body of the message and send it to query@saildocs.com, with whatever object (but not empty). 

 

You will then receive an email with the grib as an attachment, which you can open in one of the three 

grib slots. 

  

mailto:query@saildocs.com
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Squid gribs download and requests 

If you have indicated your Squid account information, you can access directly to your Squid grib 

subscriptions, or generate a mail request eventually through Iridium. To get the following screen, you 

must select a zone and request a Squid grib via the selection contextual menu, or via the Squid grib entry 

available in each grib slot. 

 

Note that you can use ctrl key to download data from several models at once (in several gribs). 

This download is compatible with Iridium GO! mode.  
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Gribs opening 

From the menu “Data->Slot 1 or 2 or 3->open” you can open a grib located on the machine. If a grib is too 

big to be loaded, you can select a zone on the map before opening it, that will limit the grib to this area. 

Gribs are automatically reloaded when the application restarts. 

qtVlm knows how to read directly (and even merge) compressed files so it is not necessary to un-

compress them before. 

The button  on the toolbar can be used to open a grib in slot 1. 

Beware that qtVlm will delete all gribs in the folder used to open the grib, if they are older than 3 days. 

This behavior can be changed in the grib general options. 

You can also open a grib in slot 1 directly from command line. 

Gribs download 

qtVlm can download gribs from various sources, either in slot 1, 2 or 3. You can select a zone on the screen 

to specify which area to download. If no zone is selected, then the portion of the map visible on screen 

will be used. 

Full VLM grib download 

VLM server provides 4 times a day a NOAA grib at a 0.5°/3h resolution, with a duration of 5 days, covering 

all world. If a selection is made on the map before downloading, the grib will be limited to this area 

although the full grib will be downloaded (35 mb). 

Partial VLM grib download 

It is the same as the full VLM grib, but only the selected zone (or the area visible on the screen if no zone 

is selected) will be downloaded. You can also do that via the contextual menu of the selection area. 
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Grib downloads via Iridium Mail and Web or XGate applications  

qtVlm is Iridium GO! certified on Android and iOS and can generate Saildocs or Great Circle emails 

requests via « Iridium Mail and Web » (IMW) or XGate applications. On Windows and MacOS only XGate 

is supported, since IMW does not exist. On Linux these applications do not exist. 

Before anything, you must select which application you will use to communicate with satellites:  

 

Then select a zone and request a Saildocs grib via the selection contextual menu: 

 

Be careful to not to select a too big area, and that your Saildocs parameters are set to limit grib file 

size to a minimum.  
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The mail is then generated and sent automatically to IMW or XGate. On iOS the corresponding 

application will be opened automatically. Your mail is ready to be send: 

 

Similarly, the grib reception is made through IMW or XGate. On Android or iOS qtVlm will be proposed 

to open the attachment: 
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Custom grib download 

You can also download in either slots a grib from a customized URL, defined in the grib options dialog. 

 

Some useful links that can be used there: 

ftp://ftp.bsh.de/Stroemungsvorhersagen/grib2 (Currents North Europ) 

SKIRON gribs are also a very useful resource: 

https://www.openskiron.org/gribs_wrf_4km 

https://www.openskiron.org/gribs_wrf_12km 

https://www.openskiron.org/gribs_skiron 

https://www.openskiron.org/gribs_icon_eu 

https://openskiron.org/gribs_icon-d2_latest 

https://www.openskiron.org/saildocs  

  

ftp://ftp.bsh.de/Stroemungsvorhersagen/grib2
https://www.openskiron.org/gribs_wrf_4km
https://www.openskiron.org/gribs_wrf_12km
https://www.openskiron.org/gribs_skiron
https://www.openskiron.org/gribs_icon_eu
https://www.openskiron.org/saildocs
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Grib configuration 

The way grib data is displayed is managed from the menu, or with the icon  in the toolbar. Arrow 

colors can be defined for each slot, to help comparing models together. 

 

Currents arrows length is proportional to Currents speed. 

The new rescale/reset buttons can be used for some variables to recompute the color scale for grib 

background based on the min/max values present in the view. Other variables will be added later.   
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Grib corrections 

You can force wind values (TWS/TWD) and apply a correction in TWS as a percentage. 

 

Wind values can be forced from instruments, and you can also ask for these forced values to tend 

smoothly toward the grib values, from a date and for a defined period. 
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Gribs information 

Information about loaded gribs is available from the Data menu or CTRL+I. It displays information about 

which data is contained in each slot, which model (when it is possible to detect), what resolution, etc. 
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Comparison between grib data and actual wind  

The last tab of the grib information dialog compare grib’s data with actual wind coming from instruments. 

 

It also shows a relevance factor (maximum relevance is 100), for TWD, TWS and the average. The values 

from grib do not take into account forced values but include eventually wind correction (see Gribs 

corrections). 
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Setting a grib date, animating the grib  

 

These icons in the toolbar are used to position the grib at a date, to move the date forward or backward, 

and to launch an animation of the gribs. 

You can also use the grib time slider to change the current grib’s date, from the grib configuration icon 

and dialog. 

 

The three lines under the days correspond to all dates in all the three gribs loaded. 

Merging gribs 

Via the menu “Data->merge grib files”, you can concatenate gribs together (of the same type 1 or 2), to 

build a single grib file from many. This is useful for instance to generate a grib file containing Winds, 

Currents and Waves that will be easier to manipulate or transfer to a mobile device. 

If the same type of data with the same date is available in several gribs, the data with the better resolution 

will be kept. 

You can merge compressed files without decompressing them. 
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Meteograms 

You can display a meteogram from any point or POI through contextual menu. 

 

 

You can select which data is displayed using the tool button at the bottom left of the screen. 
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The starting date by default is the current grib date, and you can select which date range to show. Data 

can be exported in CSV format. 

You can also ask for a grib comparison, which will show and compare TWS/TWD from each slot. 

 

In that case possible forced wind values are ignored, but any TWS correction will be taken into 

consideration. 

Note that it is possible to load NOAA weather stations data into the meteogram (via the 

contextual menu of the station). 
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You can zoom in the graph by selecting a rectangular area: 

  

Press Escape or double click the graph to exit zoom mode. 

You can also right-click the graph and a vertical red cursor will appear, showing the values for all lines: 
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Query grib data 

Similarly, you can query all gribs data at any point on the chart, or through POI contextual menu 

 

Note that you can move the magnifier, zoom/un-zoom and pan, or change grib date while inside that 

screen. 

This screen also shows magnetic variation from WMM (World Magnetic Model) at that location and at 

grib’s date, and sunset/sunrise times for that day. 
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There is a second tab available which will show Sea State, i.e. a graphical representation of wave 

steepness, period, and height. Steepness is calculated from period and height, so this two data must be 

present in the grib. 

 

The green line represents your boat’s length, as indicated in boat settings. 

The graph can be animated, and you can define a boat speed. Negative boat speed means against the 

waves (from right to left). 

Note that this assumes that the observed point is in deep waters. 
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Grib pressure 3D view 

 

This view can be obtained through the menu Data->3D pressure view. qtVlm will use atmospheric 

pressure information as elevation value. 

With a mouse use left-click to get a value, and right-click + drag to move/manipulate the camera. 
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Grib particles 

You can show grib particles from the Data menu. It is recommended to activate openGL. 

Particles will be white if the grib is shown, and colored according to TWS if not: 

 

You can tune density, speed, etc. in grib general configuration tab: 
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You can also ask for Currents particles: 

 

Ensemble Gribs 

Contrary to normal “deterministic” grib models like GFS that contain a value for a particular point and 

time, Ensemble gribs contain several values for each point. 

More information at NOAA here: https://www.wpc.ncep.noaa.gov/ensembletraining/ or here 

https://www.ecmwf.int/en/about/media-centre/focus/2017/fact-sheet-ensemble-weather-forecasting 

or here https://www.ecmwf.int/en/about/media-centre/focus/2022/30-years-ensemble-forecasting-

ecmwf  

There are 4 main “Ensemble” model categories that qtVlm can handle: 

• Ensemble models with control and members: These models (like GEFS) contain a control value 

and members that are results of same model running with a slightly different input or model 

physics. This results in several other hypotheses, 21 for GEFS, 52 for ECMWF for instance. 

• Ensemble models containing a Mean value and a Standard Deviation 

• Ensemble models containing a Median value and percentiles. 

• Ensemble models containing blended models from various sources (NBM models for instance) 

qtVlm can display this data in various forms but can also use them in routes and routing. 

  

https://www.wpc.ncep.noaa.gov/ensembletraining/
https://www.ecmwf.int/en/about/media-centre/focus/2017/fact-sheet-ensemble-weather-forecasting
https://www.ecmwf.int/en/about/media-centre/focus/2022/30-years-ensemble-forecasting-ecmwf
https://www.ecmwf.int/en/about/media-centre/focus/2022/30-years-ensemble-forecasting-ecmwf
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Values can be shown in meteograms and in Query Grib Data dialog, here are some meteograms: 
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qtVlm can show for instance control + mean as arrows, and a background colored with standard deviation. 
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Weather Images 

Weather images are either non geo-referenced images (tif, png, jpg, etc), or geo-referenced images (kml 

or kmz or geotif files). You can find weather images in many places, for instance here: 

https://tgftp.nws.noaa.gov/fax/marine.shtml, or for geo-referenced images for instance 

here https://tgftp.nws.noaa.gov/fax/, https://ocean.weather.gov/gis/index.php or here 

https://earthdata.nasa.gov/earth-observation-data/near-real-time/rapid-response/modis-subsets. 

David Burch blog also list many useful weather images that can be retrieved via Saildocs: 

http://davidburchnavigation.blogspot.com/2020/07/us-weather-map-file-names.html 

This function is helpful to compare a grib with a prevision made by a real meteorologist. 

Many predefined images are available in this module. 

Note that when an image file name is a link, qtVlm will automatically download the latest version of the 

image when you open it. This is the case for all images loaded through the “Download” button 

 

  

https://tgftp.nws.noaa.gov/fax/
https://ocean.weather.gov/gis/index.php
https://earthdata.nasa.gov/earth-observation-data/near-real-time/rapid-response/modis-subsets
http://davidburchnavigation.blogspot.com/2020/07/us-weather-map-file-names.html
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Opening a weather image 

Opening a weather image is made through the menu “Data->Weather images->Open a weather image”. 

 

Several images can be displayed at the same time. 

To manually define a Weather image, select it and press “Edit” button 
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Some not geo-referenced images are using a different projection than qtVlm. In that case the image must 

be reprojected into qtVlm projection 

 

The image can also be cropped, which is useful if the image is crossing antemeridian and needs 

reprojection (reprojecting an image crossing the antemeridian will fail). 

It is also possible to import/export predefined image configurations (qwx format). 

Pre geo-referenced images download  

Many images have been geo-referenced by Starpath, you can access them via the “Download” button at 

the end of the dialog. Image parameters are loaded into the selected item. 

Several categories are available 
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Placing a non geo-referenced weather image on the map.  

Once a file has been chosen, it is useless to capture coordinates, since it is possible to manipulate the 

image directly on the screen with mouse or fingers. Make sure the option “Lock image on map” is 

unchecked to allow that. 

qtVlm also accepts URLs directly instead of a file name. In this case the image will be downloaded each 

time the Ok button is pressed. 

Using mouse and the 4 corners, and the transparency slider at the top of the image, position the image 

where it belongs, with the help of coast lines for instance. 

 

When the image has been correctly positioned and resized, choose the final opacity, and lock it back in 

the configuration dialog. 

 

When this image will need to be updated, qtVlm will remember the position and size of this slot (up to 8). 



112 
 

Displaying KML and KMZ geo-referenced images 

Similarly, you can specify images files with a kml or kmz extension (can be an url as well, in which case 

qtVlm will download the file each time Ok button is pressed). These files are already georeferenced, so 

they will be placed and re-projected on the map automatically. On Android and iOS qtVlm is registered 

for opening these types of file automatically. 
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Weather Stations and Ships Weather Reports  

qtVlm can automatically load and display reports from Oceanic Weather Stations available at NOAA, 

Météo France, METAR, Gowind and NOAA ships reports. This is done by right-clicking somewhere on 

the chart and requesting Weather Stations download. 

 

Stations reports will be downloaded in a range from the mouse position, by default 300 NM. This default 

can be changed in the grib configuration tab (sub tab Harmonics and Weather stations) of the main 

settings. 

 

Note that in Iridium GO! mode, GOWIND stations will not be downloaded because too big (and useless 

since it contains only coastal stations). 

NOAA and some Météo-France stations have a contextual menu to show their historical data in a 

meteogram (last 45 days of data).  



114 
 

Once loaded, the reports are available via the Stations tooltips. Grib data at the same date of the report 

are also included (if available), to allow for comparison between real and grib data. 

 

Weather Stations can be removed via the menu mark->remove marks by type. 
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Simulation Mode 

qtVlm offers a Simulation Mode allowing to simulate navigation together with real AIS targets, received 

via Internet. This mode can be activated with the menu “Boat->Navigation simulation mode”. 

In this mode, qtVlm sends your virtual position to Meltemus server, and receives back all AIS targets that 

are in a 50 miles range, plus all other qtVlm boats if any. qtVlm simulation boats will appear in blue. The 

boat is helmed through a virtual rudder located under the microboard, the boat’s speed being calculated 

based on polar and gribs data. Winds, gusts and currents are taken into consideration as well as waves if 

Waves Parameters have been set. Night navigation parameters also apply. You can run the simulator 

without any gribs, motoring for instance. 

Collisions with land, ENCs obstacles and AIS targets are detected, in which case the simulation stops. 

It is also possible to drop the anchor if the boat is within 500 meters from a coast. Collisions with AIS 

targets continue to be detected even at anchor. 

In boat’s settings, a parameter allows for randomizing wind data from grib. 
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Start Line Mode 

This mode is activated through “Boat” menu. It displays a chronometer with two configurable tops, 

“Preparation” and “Attention”. 

The chronometer can be move anywhere on the screen unless the option “Lock LCDs” is checked in the 

menu Boat->Instruments. 

 

 

You must select 2 POIs to represent the start line. Please note that “Committee” POI is always considered 

to be on the right side of the line. 

You can choose to materialize crossing points on the line. A red dot will show the closest point of the line, 

and a yellow dot will represent the crossing point of the line at current boat speed and heading. The times 

to reach these points will be shown in the chronometer. 

Currents are taken into consideration. All time calculations are made related to the boat’s bow, as defined 

in boat’s settings. 

You can also ‘top” the buoy and committee positions, meaning that the current boat’s bow position will 

be used. An offset in meters can be indicated, since obviously you cannot hit the buoy or the committee. 

Note that you can also use the function Line between POIs to determine the position of a mark or object. 
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If you choose to display the Safe Area, you will get 2 zones on the start line. The red one represents the 

area where the line is reachable in time with a port tack, and the green one with a starboard tack. 

 

The 2 zones will be continuously reducing, until the chronometer reaches zero. 

Wind and Currents used for the calculations are taken from boat instruments if available. Otherwise grib 

data will be used, at the boat’s position. 

The data at the bottom of the dialog represents the time to burn, i.e. the difference between the time to 

the yellow point and the remaining time. If red the time is to be gained, if green the time is to be spent. 

Note that you can also choose to show laylines at Committee and/or buoy. 

The best side for starting will be indicated by the color of the Committee or Buoy label, which will become 

green in case it is favored. Some more information is available in the object’s tooltip concerning favored 

side calculations. 
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Race data (DCC)  

This function is accessible from the boat menu and allows for acquiring data from other boats in the same 

fleet, for instance a regatta. These data are in “DCC” format. 

This function is compatible with Iridium GO! mode, available in qtVlm internet settings. 

DCC files and positions reports  

Normally the race committee sends only once a DCC file, containing a list of all boats with their 

characteristics, then sends or make available “Positions reports” on a regular basis. 

 

The first thing to do is therefore to select a DCC file that you have placed in qtVlm “dcc” folder (or sent to 

the application for iOS). 

You can then, depending on the case, request a direct download of the last Positions Report, or request 

it through as an email through Saildocs, or place yourself Positions Reports (.txt files) directly in the folder. 

qtVlm will incorporate them when you select the “show” button. 

You can create a POI to indicate arrival or next WP. In this case qtVlm will also calculate ranking and 

distance to this point for each boat. Note that only POI of type Beacon can be used for this purpose. This 

POI will also be used as the target for the mass routing. 
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You can also ask for automatic update of the position at a time interval. Several DCCs files can be 

downloaded automatically (only one in Iridium GO! mode). The “Clear All” button removes automatic 

downloads for all DCCs. 

qtVlm calculates the speed and heading between the 2 last known positions and shows it in opponent 

boat’s tooltip and in the management dialog. It also calculates a 24h speed estimation. 
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Fleet management 

The management dialog shows a list of all boats and allows you to show or hide boats and change trace 

color. It also allows you to choose which boats can be routed. 

 

 

You can indicate a specific polar for each concurrent. 

Columns order can be adjusted. You can double-click or tap to center the view on a boat. With the 

configuration button  you can show/hide columns (click again on it to save your choices). 

Boats status can be adjusted from either Racing, DSQ; DNS, DNF or Finish. If you choose Finish you will 

be asked for a date/time of arrival. If you want to change this date set the status back to Racing and select 

again Finish. An arrived boat as its line in bold. 

The VMC column is calculated the following way: 

From the last position report, find a position report in the past as close as possible to 24h ago, then 

calculate how much progress in distance to the target has been made, and deduce from that an average 

VMC speed. 

This VMC speed is then used to calculate an estimated ETA for boats that are with a Racing status. 
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IRC calculations 

IRC calculations are made if IRC rating for a boat is indicated in the DCC file (in position 10), a starting 

date for the race and a target have been indicated in the DCC screen. 

 

You can eventually specify a penalty (in compensated time) for each boat. 

DSQ, DNS and DNF boats are excluded from the calculation. 

When a “mass-routing” is created, the routes comparator also shows IRC compensated ETA. 

 

  



122 
 

Charts 

Charts Configuration 

 

These screens, available through the menu “qtVlm->Configuration”, allows to choose which type of charts 

is displayed, and manages various options for each type. 

The toolbar has 5 icons dedicated to maps (Online, Rasters, Mbtiles, Vectors, CM93). 

 

On iOS, several methods are available to transfer maps: 

1. You can transfer them in a zip file or individual maps via Airdrop if you have a Mac. 

2. You can transfer them via iTunes share folder. Just copy the zip or the maps inside the folder and 

launch qtVlm, or if it is already launched just run qtVlm->import from iTunes folder. 

3. You can send the maps or the zip file with an email and open the attachments with qtVlm 

4. You can also export data from a qtVlm PC installation and import it on iOS, by placing the zip 

containing all exported data in iTunes share folder. 

  



123 
 

Gshhs and Mbtiles Charts 

Mbtiles maps 

These charts are files with a “.mbtiles” extension that must be copied in qtVlm (configurable) mbtiles 

folder. They contain tiles, that can be displayed offline without any internet connection. 

Mbtiles can also be generated with tools like SASPlanet, Maperitive, Mapbox, etc. 

 

Several folders can be used to store mbtiles charts. 

 

It is also possible to manage, and preview installed mbtiles, via the menu “Charts->mbtiles catalog”. 

Note that toolbar’s mbtiles icon has 3 states: on, locked, off. When in locked mode the current tile level 

is locked so you can continue zooming/un-zooming without changing the level of details. If you zoom or 

pan the map once while in locked mode, next click on the button will just unlock the level. Also not 

recommend, you can remove “Overzoom” indication on tiles if that is the case.  



124 
 

Visit My Harbour Charts 

These charts can be acquired here: Visit My Harbour website 

They can be installed from a dongle (Windows only), or from a DVD, or as a downloaded zip file. These 

files (.vmh and .hdx extensions), must be copied in one of the mbtiles dedicated folders. Activation of 

these charts is made through “VMH Activation” button, an unlock code will be requested. 

For more information about transferring files on Android and iOS, see the chapter File management on 

mobile versions. 

Charts delivered on dongle do not need activation. A dongle can be used on several Windows 

machines. Dongles can be used only with Windows PCs. 

Activation codes can be used only once and are therefore linked to a specific machine.  It is not 

possible to use Visit My Harbour charts on a virtual machine. 

Please check Visit My Harbour website for complete details about their products and licenses. 

 

  

http://www.visitmyharbour.com/
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GSHHS Charts 

Gshhs charts consists in coasts lines at different qualities and scales. qtVlm cannot run without them. 

 

Several parameters are available in the settings, like showing country names, towns, borders and rivers. 

Land and sea color, coast lines width is configurable too. The location of the maps can be changed, for 

instance on Android to move them on an external memory card. 
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Online Charts 

Online charts need an internet connection for the tiles to be downloaded. A cache system avoids 

downloading tiles each time they are displayed. Several kinds of this maps can be displayed. 

The location of the cache together with its maximum size can be configured. 

VLM tiles 

VLM tiles are based on the same maps as gshhs but are coming as tiles from VLM server. Rendering is a 

bit faster than local gshhs, and they also have some coloration for relief. 
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OpenTopoMap tiles  

These tiles need to have the gribs displayed on top of them, with a configurable transparency. 

 

OpenStreetMap tiles 

These tiles are available only on mobiles versions (Android and iOS). The sea is transparent and therefore 

the grib can be displayed “under” them. 
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OpenSeaMap tiles 

These tiles can be displayed over any other types of maps. They contain only sea objects like buoys, 

lighthouses, etc.   
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Rasters Charts 

These charts are georeferenced images, such as kap, geotiff, geojpeg, etc., and must be placed in qtVlm 

kaps folder (location can be configured in the parameters). A single raster or ENC chart can be displayed 

(menu “Charts->Single chart”), or qtVlm will automatically choose which chart to displayed, according to 

display zoom level and chart’s compilation scale. On iOS these kinds of charts can be imported through 

iTunes, Airdrop, etc. Geotiff from SHOM can have their borders automatically removed.  

 

NVCharts 

NVCharts are supported only on Windows. You just need to indicate the folder containing them in the 

list of charts folders, by default NVCharts are installed in C:\Chartkit. 

 

NVCharts point of interests can be loaded via the menu “Marks->Import”. Several mrk files can be 

loaded at the same time. To access detailed information right-click on the item (or tap long). These 

points can be removed by calling again the import dialog and pressing cancel when asked for files 

names.  
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Vector Charts 

These charts are available for free for some countries like United States or are sold by various official sites 

like SHOM for France. You can also purchase Meltemus Charts Packs from our site. 

Like Raster’s maps, they must be placed in a configured folder. 

Many display options are available: 

 

Coastlines and other dangers from vector charts can be used in all chart modes. Please see Danger 

detection chapter for more details. 

A “Default settings” button allows you to reset the configuration to be default ones. 

  

https://www.meltemus.com/index.php/en/meltemus-charts
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Highlighting objects with extra information or with date dependency  

 

When “Highlight objects with extra information” is checked, qtVlm will highlight objects with extra 

information (INFORM, NINFORM, TXTDSC, NTXTD and PICREP attributes). Only objects with PICREP 

attribute if “Only with image” is also checked. 

 

When “Highlight date dependent” is checked, qtVlm will draw another special symbol for object 

depending on dates (for instance a seasonal light), based on DATSTA, DATEND, PERSTA or PEREND 

attributes. 
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Lights 

Lights can be hidden completely thought the display menu and the toolbar, and sectors can be amplified, 

by hovering on them: 

 

The lighthouse icon in the toolbar has three states: Lights hidden, lights shown, and lights visible from 

boat: 

 

By default, sector lights information is not printed on the chart to avoid too much cluttering. There Is an 

option to force the rendering of this data. 
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Chart Information 

Through rich-click on a chart->Chart Information you can get general information about the chart: 

 

In the list of Depth contour, the one in bold and underlined is the Safety Contour. If no safety contour has 

been found a default Safety Contour will be eventually chosen and will be displayed italic and underlined. 

If the chart is a S63 chart, the permit’s expiration date will be shown too (in red is expired, I n yellow if it 

expires in less than 30 days). 

You can click on the scale button to see the chart at exactly it’s compilation scale. 

Note that depth contours values can be displayed directly on the chart. 
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Pick-up reports 

S57 objects can be queried, through the map contextual menu: 

 

When the vector pickup dialog is shown, a magnifier icon appears at the place you are querying. You can 

use this icon and move it without quitting the pickup mode, to explore the charts displayed on the screen. 

 



135 
 

By clicking on the eye icon close to class name, you can highlight the feature on the chart itself: 

 

 

For French charts and if “SHOM balisage” (see here: SHOM Open Data Shapefiles) has been downloaded, 

objects images can be directly displayed from this screen. 
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Charts at that position 

Via the contextual menu, you can choose to display the list of charts available for a given position. This is 

especially useful for zooming at the exact compilation scale of one of the charts available. Included charts 

are RNCs (if ‘R’ icon is on) and ENCs (if ‘V’ icon is on). Charts must belong to the activated group, if any. 
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Overzoom indicator 

In case at least one chart is over zoomed (meaning at least 2x its nominal scale), an overzoom indicator 

will appear the top of the screen. This label has a tooltip explaining which charts are over zoomed and by 

how much. 

 

In addition, you can choose to display S52 standard symbol for over scaled on the chart. 

 

Overscaled symbol:
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Objects search 

You can search vector charts for a particular object. This function is available from the Charts menu (or 

CTRL+F). 

 

There are 2 types of searches available: 

- Displayed charts: this allows to search with very precise features and attributes values. It is 

limited to charts currently displayed or recently visited during this session (i.e., in memory). 

- Full S57/S63 or CM93 search: this will ask you to generate a database the first time you attempt 

to search for that. This build can take some time depending on your machine and your installed 

charts. After building the databases you can only search for objects name (OBJNAM), but this is 

available whatever the displayed charts. You can regenerate the databases if you delete them 

from the main configuration dialog (charts->rasters and vectors). 

If you select a zone before launching the search, then the search will be limited to this area. 
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S57/S63 updates analysis  

When you load a single chart via Charts menu, you can study all the updates that were published for this 

chart, and you can load them one by one to study what has been changed. 
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By hitting the button “Load and review chart up to selected update”, qtVlm will display the chart up to 

the selected update and will display specific S57 symbology for updated/added/deleted features. 

Please note that if you have selected a specific object the chart will be centered on it. 
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3D view 

From the Charts menu you can request a 3D view of your current display. This will use shapefiles data if 

any is loaded, or Land Elevation features (LNDELV) in your charts. Depth Areas (DEPARE) will also be 

used for water zones. You can also load a GEBCO (or UKHO) file with elevations and depths, in TIF format. 
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Use left click to show values, and right-click + drag to manipulate the camera. The slider at the top is for 

light intensity. 

A slider allows for adjusting light intensity. 
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S63 Charts 

S63 maps are encrypted version of S57 charts sold by various provider. They guarantee that only the 

buyer can display them on his devices. In order to be able to purchase charts, you will need to provide the 

seller a way to identify you: The User Permit. 

An example of web site where you can purchase those charts: Chartworld (on this website, if an 

hardware ID is requested, leave the field blank as it is not the one provided by qtVlm that is asked here) 

In order to get a User Permit for qtVlm you can either go on our website where you will find a complete 

description of the process: https://www.meltemus.com/index.php/en/s63. 

To associate a User Permit to a device or PC, the simplest way is to go to menu qtVlm->Licenses 

Management. 

Alternatively, you can setup the User Permit manually in the S63 configuration screen (available at: qtVlm 

➔ Configuration ➔ Charts ➔ S63). 

 

The acquisition of a user permit consists in four steps: 

- You purchase a user permit (15€ at the time of writing of this document). 

- We send you back via email a user permit which you will input in qtVlm S63 parameters. 

- You send us back via email the hardware id of your machine. 

- And finally, we send you the Activation Key for this machine. 

An activation key allows you to purchase as many charts as you want on a particular machine. A user 

permit can be used to generate three activation keys for 3 different machines. 

https://chartworld.com/web/
https://www.meltemus.com/index.php/en/s63
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To add a chart in qtVlm you will first need to copy all the files in a subfolder of S63 folder in qtVlm folder 

tree. In the S63 folder you will also need to put the PERMIT.TXT obtained when you have purchased the 

chart. 

Use the second part of the configuration screen to configure the map path: 

 

You can also store all the files received from the chart’s provider in a zip file and use the “Import” button. 

Once the S63 charts are configured, the S57 charts parameters defined in “Rasters and vectors” section 

will apply. 
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NOAA Charts Catalog 

From the Charts menu you can show and manage NOAA charts installation and updates: 

 

The program will first automatically download NOAA catalog. If internet is not available, you can only 

remove charts (installation and updates are not available). 

Note that NOAA usually updates chart every Thursday mornings (EST time). 

You can filter charts by district, regions, or states. Columns are sortable. Note that you can also select an 

area, right click on selected zone and choose NOAA catalog, in which case you can load/update charts 

for that area only. 

Double clicking on a chart will open it in single chart view mode. 

By default, NOAA charts are installed in qtVlm folder under “noaa_enc” but you can choose another 

folder and already installed charts will be moved. This option is not available on Android or iOS. 
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Charts Grouping 

For mbtiles charts and Rasters/Vectors charts you can create groups of charts, allowing to easily switch 

from one set of charts to another. 

This is done via the chart folders definition: 

 

Once defined, you can choose which group of charts is displayed via the “Charts” menu. 

  



147 
 

Danger detection 

If no vector charts are installed, only GSHHS basic coastlines can be detected by qtVlm. On the contrary, 

you can choose to use coastlines and dangers from vector chart, in the chart’s configuration screen. 

 

Vector charts settings for danger detection  

When the above option is checked, qtVlm will use the objects from the vector chart to identify dangers 

in routes and routings modules, in the reckoning tools, and in the ruler tool. 

These objects will be used even if you are not actually displaying a Vector Chart. Therefore, with this 

parameter you can for instance use a Raster chart and use “underneath” a vector chart for detecting 

dangers. If no vector chart exists for a particular area, no coasts nor dangers will be detected since 

the GSHHS coastlines are not loaded in that case. 

Note that in S57/S63 mode objects from these charts are used even if you have selected CM93 as dangers 

source, and in CM93 mode only objects from CM93s are used. If “Coastlines from vector charts” is 

unchecked then only GSHHS coastlines are used, even in Vector mode. 

We distinguished between dangers and obstacles: 

Dangers are objects with a sounding less or equal to Safety Contour, or buoys and beacons. Obstacles 

are objects with a sounding less or equal to Shallow Contour. 

Dangers will turn Cone, COG predictor line and Ruler tool in orange, while obstacles will turn them in red. 

Both dangers and obstacles can trigger an alarm. Obstacles are avoided by routes and routings and going 

through them in Simulation mode generates a grounding.  

Included objects are: 

• Coastlines and Lakes contours, 

• Rocks, Obstructions and Wrecks, 

• Landmarks that are wind motors, 

• Depth Contours and Safety Contour, 

• Depth Areas at shallow depth, 

• Land areas, 

• Pontoons, Shoreline constructions, hulks (boats moored permanently), unsurveyed areas, 

floating docks, logpons, ice areas. 

• Soundings. 
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In addition, you can configure optional objects that will belong to the obstacles list: 

 

Safety Contour parameter in charts parameters is particularly important. It is used to identify Depth 

Contours that will be drawn with a thicker line. Please note that if there is no Contour Depth matching 

exactly your setting, the next Contour Depth object will be used unless the next Contour Depth object as 

a depth more than 67% if setting is <= 10m or 33% if > 10m. In that case a default Safety Control will be 

drawn. Safety contour is a danger, but not an obstacle. 
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Danger detection tools  

The Ruler tools and all reckoning tools can detect dangers  

For instance, here is Danger and Obstacle Detection by the ruler tool: 

  

The boat’s tooltip will also show a distance to closest Danger: 
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Reckoning tools of types “Cone” and “Vector” can be configured for angle and width from the boat 

parameters tab in the main configuration dialog. 

 

The length of these tools can be modified directly from the toolbar. 

          

Danger Detection Alarm 

You can use the Cone and the Vector reckoning tools to trigger a sound alarm: 
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Shapefiles and SHOM Open Data 

Generic Shapefiles  

qtVlm can load and display generic shapefiles, which need to be configured once to display relevant data. 

You can open .shp files or zip or tar.gz files containing shapefiles. This is done via the menu “Charts-

>Shapefiles”. 

When you open a generic Shapefile for the first time, qtVlm chooses the first data field available as the 

key to display the shapes legends. For instance, in that case that is “Expiration” which obviously is not 

what we want. 

 

You can change this by selecting another field, in this case a much better choice is “PROD_TYPE” 
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qtVlm will remember your choice next time you open the same shapefile, even if it has been updated. 

If one of the fields contains an URL, you can open it by double-clicking on it: 

  

Two links to interesting shapefiles: 

https://www.weather.gov/gis/MarineZones 

https://www.marineregions.org/downloads.php 

  

https://www.weather.gov/gis/MarineZones
https://www.marineregions.org/downloads.php
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Showing shapefiles in 3D 

Once you have a shapefile loaded, make sure you select some elevation field. Then from the view menu 

select “3D Shapefiles/ENCs view” and your chart will be rendered in 3D using elevation data from your 

shapefile. 

 

You can zoom, show values with left click and manipulate the camera with right-click + drag. 
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Using shapefiles as barriers or coastlines for routes and routings modules  

Shapefiles can be used as barriers. For instance, if you do not want to use the imprecise gshhs coast lines 

from gshhs, you can specify in Charts configuration that you want to use coasts lines from vector charts, 

load a shapefile and indicate that you want to use it as a barrier. qtVlm will then stop using gshhs and will 

use the shapefile and eventually the vector charts if any for all coast’s detection functions. 

 

In the above example a shapefile is used instead of gshhs for detecting coasts at Lac Léman. 
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SHOM Open Data Shapefiles  

You can also display Shapes files coming from SHOM. These charts are French, and this part is not 

translated into English. 

The display of these charts is made through the Charts menu, via the shapefile command. Current Open 

Data from SHOM can be downloaded directly from this dialog, or from the menu: 

 

 

Currently available data are seabed nature, cables, wrecks, administrative limits and toponomy. Since 

5.8.9 Buoys and Lights are also available, with pictures in most cases. 

Depending on the type of data selected, several options will be presented. A tooltip will be generated on 

the screen to display objects available data.  
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For instance, here is a map showing seabed nature: 

 

Cables: 
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Here is the screen showing wrecks: 

 

And here is an example of the kind of data you can find: 
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Buoys look like this: 
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Size of buoys icons, showing or not lights and showing or not labels can be configured in the main 

configuration screen: 

 

Fisher Island seagrass shapefiles  

Thanks to Henry L. Ferguson Museum in United States, there is a special function for downloading and 

showing seagrass areas around Fisher Island. 

 

This feature shows a tooltip on each category of seagrass and triggers an alarm when you enter in it, for 

instance “Anchoring prohibited” or “Speed limit is 5 kts”.  
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NMEA Connections and Internal Sensors  

This configuration screen is available via menu “qtVlm->Configuration” and allows to configure NMEA 

connections. This configuration screen consists in 3 tabs (Incoming connections, outgoing connections 

and other options) and 6 tabs on mobile version (Incoming, Outgoing, Sensors, WP, options). 

Note that NMEA 2000 is not supported. 

Using several connections simultaneously is supported. 

Incoming connections 

You can decide to immediately start NMEA acquisition when qtVlm is launched. 

This is divided in 2 parts, local sources and network sources. 

Local sources 

 

Replaying a file 

You can specify a file containing NMEA or AIS sentences as an input. The speed of the replay is a 

parameter from 10 to 5000 ms and you can also specify how many sentences are read and send to 

instruments at each iteration. When the file is completely read it restarts from the beginning. 

The optional sliders allow for changing dynamically the speed of the replay, and the position in the file. 

If the speed slider if moved completely on the left the replay just pause.  
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Serial connections 

If the port does not appear in the list, you can create a custom port, this is sometimes useful on MacOS 

or Linux. 

Serial connections are not available on Android and iOS (except on Android for the special case of a 

dAISy). 

Please note that a GPS-USB on Windows must be configured through a serial port after installation of 

the relevant GPS-USB driver. On Windows 10 and MacOS, it might be possible to connect to a GPS-USB 

directly using internal connection. 

Internal GPS 

“All sources” should normally be unchecked, meaning that qtVlm should not use internet-based 

localization systems, but only real GPS fix. 

Internal GPS data can be converted into NMEA messages (position, COG and SOG), and send over NMEA 

outputs. qtVlm will also send RME message (position accuracy in meters). On Android and iOS this option 

is available only with the full version. 

Network sources 
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TCP 

You can activate a timeout on TCP connections that will trigger a reconnection if nothing has been 

received for 6 seconds. 

You can use B&G WebSocket to get data from B&G H5000 processor. This is configurable only on TCP 

incoming network connection number 3. AIS feed cannot be retrieved though this WebSocket. qtVlm 

uses in priority damped values if available. 

UDP 

You can specify a server IP address for UDP incoming connections. This address is used only in case of 

Multicasting, and therefore the default value (0.0.0.0, meaning any IPV4) should be used in most cases. 

You can also indicate “Any”, which stands for any IP addresses (IPV4 and IPV6). 

Outgoing connections 

 

The output channels are used to send current WP information to a navigation system. It can also be used 

to send performance data to various instruments. There is also an option for retransmitting all NMEA 

data on a port. 

If “retransmit all” is checked, qtVlm will send all NMEA messages it receives on these ports. 
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NMEA filtering 

You can set up filters for both incoming and outgoing NMEA messages, via the button available on 

each connection. Filters can be set as exclusive or rejecting. 

 

Message to be treated by the filter must be separated by semi column. For instance, if you want to filter 

all AIS messages just a “!” is enough in the list of strings. 

NMEA raw data 

If you activate NMEA raw data window, you will be able to see all incoming and outgoing messages 

Color codes are: 

• White: incoming NMEA message 

• Red: error message 

• Yellow: AIS message 

• Cyan: outgoing message 

• Green: information message  
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Other options 

 

An option allows to set qtVlm date to GPS date instead of machine’s internal clock. 

According to the official NMEA documentation, MWD message contains Ground Wind data. If the option 

is unchecked qtVlm will consider that MWD message contains Sea Wind data and will calculate Ground 

Wind. 

It is possible to send grib wind data at boat’s position to NMEA output via a MWV message. 

If “Record NMEA data” is checked a new file containing all received data will be created each time NMEA 

acquisition is restarted. 

You can also display a circle around the boat materializing the position precision. This is available only if 

you receive RME NMEA messages, typically from a Garmin GPS or if qtVlm is sending NMEA messages 

from iOS or Android versions. 
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Sending or receiving WP related information  

 

If “Treat RMB messages (WP) is checked, qtVlm will automatically create and activate a POI when it 

receives a RMB message. 

You can also choose which messages are sent concerning active WP (RMB, WPL, BWC, BWR, ZTG, VMC, 

XTE and XTR). 

“B&G ws” if for sending WP data through WebSocket (note that not all B&G processors support this). 

You can also send APB message (Auto Pilot), either in true or magnetic mode, and choose to send 

Heading to WP (Course to steer) or Heading to Steer (Heading compensated by currents).  
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Internal sensors 

qtVlm can use internal sensors, typically on Android and iOS devices (full version only). 

 

If a sensor does not exist on your machine, the corresponding line will be grayed out and disabled. 

qtVlm can also convert these signals into NMEA messages and send them over the NMEA outputs. Note 

that you can also convert internal GPS data into NMEA messages (Position, COG and SOG) and send 

that to NMEA outputs. See NMEA Connections for more details. 

The Heel and Pitch sensor can be configured to automatically reverse axes depending on the device 

orientation. “Vertical mode” allows for instance to use a phone fixed on a vertical partition. 

There is also a command in the menu Boat->Instruments to calibrate the sensor. This will set the current 

heel and pitch angles as zero. Useful for instance if your device is positioned vertically. 
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Sending performances data  

 

qtVlm can send performances sentences on NMEA output port, to be displayed on NKE, Raymarine or 

B&G instruments. These data consist in theoretical polar speed (1), opposite track heading with the same 

TWA (2), target speeds for CMG and VMG (3), optimum polar angles for upwind and downwind (4), and 

currents direction and speed calculated by qtVlm (based on COG, SOG, CTW, STW) (5). 

Data smoothing and corrections  

 

It is possible to smooth data received for wind speed and direction, and boat speed and direction. The 

value indicates the number of last received data that should be averaged. As these data are used in all 

calculations, it allows to carefully tune the sensibility of instruments, for instance Polar Efficiency 

Percentage (PPC). The default value (1) means not smoothing. 
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qtVlm Companion 

qtVlm can also pilot “qtVlm Companion”, which is an application for Android devices and especially 

Android Wear devices. It can display all the data send by qtVlm, and has several other modules like 

Maps, WPs, Anchor, Race Start, Alarms, etc. 

 

 

 

See Companion documentation for more details. 

 

  

http://download.meltemus.com/qtvlm/companion_documentation_en.pdf
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NMEA activation 

NMEA connections are activated either with the microboard or with the main board. You can also choose 

to start NMEA automatically at qtVlm’s startup.   
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The frequency at which qtVlm will update data coming from NMEA connections is configurable in the 

main board. Especially on Android and iOS, a too small value can have a huge impact on battery usage. 

When a position has been found (fix), buttons turn green. If no position has been found yet, buttons are 

colored in red.  
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AIS Module 

Apart from this documentation, you can find many details about AIS in qtVlm in David Burch blog: AIS in 

qtVlm 

Configuration 

Many options are available in AIS module. 

 

The first option filters out targets based on their distance to boat. 

It is also possible to filter out targets based on their types, or to display only targets belonging to your 

friend’s list. 

The 2 average SOG values are used when displaying the fleet to compute average speed for the given 

duration. 

  

http://davidburchnavigation.blogspot.com/2022/05/qtVlm-AIS.html
http://davidburchnavigation.blogspot.com/2022/05/qtVlm-AIS.html
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You can filter targets based on their class: 

 

Options controlling CPA (Closest Point of Approach) and TCPA (time to CPA) allows to configure alarms 

(sound and/or visual). Real boat sizes can be used for these calculations. These calculations can be 

deactivated completely. 

 

The list of all AIS targets can be obtained through the “display” menu. From this list, it is possible to 

display/hide tracks or tracking info, to add remove a target from your friend’s list, or to center the map 

on a target. It is also possible to manage the friend’s list members, even if their MMSI are not listed. 

Optionally, VBO messages can be treated for instance to update your position, heading and speed. 
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Connecting a dAISy to an Android device USB port.  

While a dAISy (AIS receiver) can easily be connected on a PC serial port, it is also possible to connect it 

directly on an Android device, with an USB-C cable: 

 

To be recognized by qtVlm, you also need to activate this connection in NMEA settings: 
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Usage 

Target details  

Targets have a tooltip information, which summarize main information concerning it. They also have a 

contextual menu allowing to display more details. Their color indicates their status (green if all details 

have been received, yellow otherwise), or if the target is generating a CPA alarm (red in that case). Lost 

targets, i.e., targets that didn’t emit anything during a configurable time, are displayed in grey. They are 

deleted after 3 times this time. 

It is also possible to search and display this target on Marine Traffic (internet connection required). 

Other options manage trace’s display and reckoning. 

 

 

You can also add or remove this target from the fleet list. In this case the target will appear a bit darker 

on the map. You can also decide to display only targets belonging to your friend’s list. 

You can also display additional tracking data in the target label. In that case targets will also be shown 

in the “AIS fleet” instrument. 
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AIS Fleet instrument 

Through the icon  in the toolbar or via the View menu, you can display the AIS Fleet instrument. AIS 

targets belonging to the fleet or displaying dynamic data are included. 

 

This window behaves like an instrument and can be left opened. 

%SOG is the percentage of the target’s speed compared to your speed. 

%SOG (fleet) is the percentage of the target’s speed compared to the average speed of the fleet. 

You can change the columns order. 

A double click on a line will center the view on the target. 

From this dialog you can also toggle between “show only fleet” and “show all AIS targets” 
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Alarms, CPA, TCPA 

Depending on parameters, AIS module will generate sound and visual alarms. A target generating a CPA 

alert turns red with a flashing dot. A configurable sound is also played, see Alarms module. A sound alarm 

can be deactivated for a specific target, temporarily or forever. 

Sound media can be different for ClassA, ClassB, MMSI presence or SART alarms. 

You can also configure a list of MMSI (for instance the list of personal MOB devices), and an alarm 

will be generated immediately if one of these MMSI becomes active. 

If the sound alarm is deactivated, the visual signal becomes blue. This allows to find which targets are still 

generating a sound alarm, since they are still red.  

 

Real boat size can be taken into consideration in CPA calculations, if the distance to the boat is less than 

a configurable value. Your own boat size must be defined in your boat settings (menu “Boat->Boat 

Settings”). Boats are drawn in real size if the zoom level is big enough. 

 

Please note that boat’s length is equal to A + B and boat’s width is equal to C + D. Draught is not used for 

the time being. 
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AIS via Internet 

It is possible to display targets acquired from Internet, via our server. 

Receiving AIS targets via Internet implies that you also send back your own real AIS feed (if any) back to our 

server and AisHub server. Your own position or data (VDO message) is not sent to AisHub. 

Warning: AIS targets acquired through internet are NOT accurate, due to the delay for updating their 

position and status through all the servers. 

To avoid overloading your system with thousands of targets, only targets within 50 NM circle from your 

position are sent. There is no distance limitation for targets representing users sharing their position. 

If a target is acquired both via internet and via transducer, the target via internet is ignored. Internet 

targets are marked with a red dot to distinguish them from regular AIS targets. 

 

Various options are available: 

You can choose if you agree to share your position with other qtVlm boats (reals or in Simulation Mode). 

If you choose to share your position, you can also decide if you want to receive only real boats that are in 

your friends list. And finally, you can decide whether you want to see Simulation Boats and use the Virtual 

VHF to communicate with other qtVlm users. The Virtual VHF is in the main board, last tab. 

This function can be used for instance to retrieve positions for a fleet participating in a regatta. 
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Inland AIS 

qtVlm decodes specific Inland European information (blue flag, number of blue cones, loaded/unloaded 

status, and various information specific to Inland regulation). 
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Area Notices 

qtVlm support Area notices (broadcasted). Il will show various geometry and the notice itself is displayed 

as a tooltip 

  

Areas are colored in red for Distress Areas, in light red for Security Alerts, in orange for Caution areas, in 

green for Environmental Caution areas, in pink for Restricted Areas, in yellow for Anchorage areas, in 

blue for Instructions areas, in light blue for Information areas, in dark blue for Chart Feature areas, in 

white for Ship Report areas, in gray for Route areas, and in black otherwise. 

Detailed dialog is shown with right-click on one of the shapes belonging to the Area Notice. On mobile 

the detailed dialog is shown by pressing more than 1 second on the area. 
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Weather Stations 

Weather stations are shown with a dynamic wind arrow if they have data concerning wind. 
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Instruments 

There are 2 sets of instruments: those displayed over the chart and those displayed in a dedicated 

separated panel. In both cases, all instruments (LCDS, dials and histograms) can be shown/hidden, 

moved and resized. LCDs colors can be specified individually. For instance, it’s possible to have a limited 

number of small instruments on the map, and a larger set of bigger instruments in the panel. Both sets 

of instruments can be shown/hidden via the toolbar icons  and .Please note that in both cases 

the configuration depends on the screen orientation. Note that instruments panels have 2 possible 

configurations. 

The “lock all” button locks both sets of instruments (on chart and panel). 
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Instruments over charts 

Instruments selection 

Instruments selection is made through the menu “qtVlm->Configuration”, instruments tab. 

 

Each instrument is made of an LCD plus eventually a dial and eventually a histogram. The size of the 

digital displays can be adjusted in the configuration dialog, General tab. The dial is displayed/hidden by 

pressing shortly on the digital display, and the histogram by a long press. It is recommended to activate 

only histograms you really need since histograms are quite costly resources wise. 
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Moving and resizing instruments  

To be able to move and resize instruments, you must first unlock them. This is done via the menu Boat-

>Instruments. 

 

Once unlocked, instruments can be move with the mouse or finger, and can be resized via the small icon 

at their bottom right: 

 

You can also change the background and the foreground colors for LCDs. 
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Instruments panel 

This panel displays instruments without anything else, over all other elements like charts, boat, POIs, etc. 

 

You can change light mode to dusk or night with the icon  

 



185 
 

 

Instruments panel selection  

 

 

Instruments selection is made via the +/- button, which is shown when the lock icon is opened. 

The green arrow allows you to configure two different panels. 
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Instruments panel moving and resizing. 

When the lock icon is opened, you can move and resize instruments at your will. The procedure is the 

same as for the instruments on the map. 

The red eye in LCDs can be used to hide the LCD while keeping the dial and/or the histogram: 

 

Other instruments parameters  

Histograms abnormal values filter  

In the general instruments settings you can request to show the “filter abnormal values button”. 

 

In that case a filter button will be displayed in each histogram, which when press will remove any 

abnormal values (if any), based on a standard deviation formula. 
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Statistics 

From the boat menu, you can request statistics that will show minimum/average/maximum values for 

different periods of time for SOG§STW/TWS and TWD (for TWD only average is calculated). 

The collection of data must be activated in Instruments configuration tab: 

 

The save button exports all collected data in CSV format. Filter button removes abnormal values based 

on standard deviation. If possible, AWA and AWS will be calculated from other data when exporting in 

CSV format. 
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Calypso instruments via Bluetooth  

It is possible to connect Calypso anemometers via Bluetooth. This is done through the boat menu. 

 

 

Note that it is possible to convert all incoming signals to NMEA messages and send them on NMEA 

outputs. 
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Available Instruments 

COG: Course Over ground 

 

   

This instrument displays Course Over Ground, plus heading/distance to WP (in blue). The background 

boat shape is oriented according to CTW. 

SOG: Speed Over Ground 

 

This instrument displays Speed Over Ground. The maximum speed reached is also displayed. 
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VMC: Velocity Made Course 

 

This instrument shows Velocity Made Course, also called VMG toward waypoint. 

XTE: Cross Track Error 

 

This instrument shows the distance between your position and a theoretical route, in meters. An active 

WP or an XTE reference must have been defined, this is done through the route contextual menu. XTE 

reference can be deleted from the route menu. See Routes Module for more information.  
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TSP: Target Speed 

 

This instrument expresses the speed (STW) in percentage of optimum speed as given by the polar to 

reach the WP. Optimum speed is the speed on water corresponding to the best VMC towards the WP. 

For instance, for a WP upwind, too much speed means you must luff up a bit, while a percentage lower 

than 100% means you must bear away a bit. For steering, this information is often more efficient than 

VMC 

PPC: Polar Percent  

 

This instrument shows the difference between actual speed and theoretical polar speed, as a percentage 

and as values. It is also possible to send this data through the NMEA output port in order to display it on 

NKE or Raymarine instruments. 
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TWD: True Wind Direction 

 

This instrument shows True Wind Direction. If NMEA data do not provide it and if it is possible, qtVlm will 

calculate it based on COG, SOG and apparent wind data. The arrow’s color changes with wind speed, and 

boat orientation is drawn on background. 

Histogram associated with TWD consists in the deviation from the period mean value, which allows you 

to know if the wind is heading or lifting. 

 

In the main instruments’ configuration tab, you can also ask for “TWD distribution in TWD histogram”. In 

that case the histogram will also show a band representing the statistical distribution of TWD (black 

means less occurrences, yellow means more occurrences). 

What this tool provides is a view of the general trend for the wind oscillations, and lets you see quickly 

which side of the course the wind oscillations are biasing.  This can be useful in helping decide which side 

of the course you want to develop leverage on the fleet on. 
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TWA: True Wind Angle 

 

This instrument shows True Wind Angle. If NMEA data do not provide it and if it is possible, qtVlm will 

calculate it based on COG, SOG and apparent wind data. The value and the arrow are green when TWA 

is inside the polar VMG limits, red otherwise. The digital display also shows a red or green dot, depending 

on the tack. The red parts on the dial represent the polar VMG limits and are recomputed dynamically. 

This instruments also shows all other wind data (TWD/TWS/AWA/AWS). 

If you click or tap on the upper label of the gauge, you will enter close-hauled mode (press again on the 

label to exit): 

The angle limits of the close-hauled mode (here 0°/70°) can be configured in the Instruments settings 

(minimum and maximum). 
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TWS: True Wind Speed 

 

This instrument displays True Wind Speed. If NMEA data do not provide it and if it is possible, qtVlm will 

calculate it based on COG, SOG and apparent wind data. 

AWA: Apparent Wind Angle 

 

This instrument displays Apparent Wind Angle. If NMEA data do not provide it and if it is possible, qtVlm 

will calculate it based on COG, SOG and real wind data. 

Tack side is represented with a green or red dot over the digital display. 
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AWS: Apparent Wind Speed 

 

This instrument displays Apparent Wind Speed. If NMEA data do not provide it and if it is possible, qtVlm 

will calculate it based on COG, SOG and real wind data. 

GWS: Ground Wind Speed 

 

 

This instrument displays Ground Wind Speed, which is the vector subtraction of Sea Wind (TWS/TWD) 

and currents. 
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GWD: Ground Wind Direction  

 

 

This instrument shows Ground Wind Direction, which is the wind blowing on Earth as opposed to 

TWS/TWD which is the wind blowing on the sea. 

CTW: Course Through Water 

   

This instrument shows Course Through Water. It is different from COG in case of Currents, for instance. 

It also displays heading/distance toward current waypoint (in blue). The background boat shape is 

oriented according to COG.  
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STW: Speed Through Water 

 

This instrument shows Speed Through Water. It is different from SOG in case of Currents, for instance. It 

also displays the maximum value measured. 

HDG: Heading 

   

This instrument shows heading as measured on a Compass. It is different from COG in case of Currents, 

for instance. It also displays heading/distance toward current waypoint (in blue). The background boat 

shape is oriented according to COG. 

CNM: Course to Next Mark 

 

This instrument shows heading toward current WP. There is no dial since this information is already 

displayed in CTW and COG dials. 
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DNM: Distance to next mark 

 

This instrument shows the distance to active WP. 

CS/CD: Currents Speed and Direction 

 

Currents Speed and Direction are either received from NMEA input, or calculated by qtVlm from COG, 

SOG, CTW and STW. Please note that Currents direction indicates where the Currents goes, contrary to 

Winds for which direction indicates where wind come from. 

The boat orientation is drawn on the background of the dial. 

DPH: Depth 

 

This instrument displays depth as received from NMEA data. This instrument has no dial, but historical 

data can be displayed through its histogram. 
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PRE: Atmospheric Pressure 

 

This instrument displays pressure as received from NMEA data or internal sensor. This instrument has no 

dial, but historical data can be displayed through its histogram. 

 

HEEL/PCH: Heel and Pitch  

 

This instrument shows Heel Angle, and in its dial shows also Pitch angle: 

 

The “mast-needle” is articulated so it shows the correct heel graduation whatever the height of boat and 

water. 
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Another particularity is that it is updated as soon as a signal is received, regardless of the value set for 

NMEA updates frequency. 

 

Pitch can be filtered out in Instrument’s options. 

ATP: Air Temperature 

 

This instrument shows Air Temperature in °C 
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TP: Sea Temperature 

 

This instrument displays Sea Temperature in °C 

 

RPM: Rotations Per Minute 

 

This instrument does not have an associated gauge or histogram. 

RUD: Rudder angle 

 

This instrument does not have an associated gauge or histogram. 

PSP: Polar Speed 

 

This LCD display theoretical polar speed for the current couple TWS/TWA. It does not have an associated 

gauge or histogram. 
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T_TWA: Target TWA 

 

This instrument displays optimal TWA for current wind speed. It does not have an associated gauge or 

histogram. 

T_AWA: Target AWA 

 

This instrument displays optimal AWA for current wind speed. It does not have an associated gauge or 

histogram. 

T_TSP : Polar speed corresponding to T_TWA/TWS 

 

This instrument displays the polar speed corresponding to the couple T_TWA/TWS. It does not have an 

associated gauge or histogram. 

VMG: Velocity Made Good 

 

This instrument shows VMG (to wind, as opposed to VMC which is related to activated WP). 
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ROT: Rotation per minute 

 

This instrument shows the boat’s rotation angle per minute. 

LAT and LON: Show current boat’s latitude and longitude  

 

DTW: Distance Traveled through Water  

 

Since last reset or simulation mode restart. 
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Boards 

Microboards 

The microboard is always located on the top-right corner of qtVlm. You can hide/show it from general 

settings, boat’s tab, and you can also choose between VLM Microboard and Tactics Microboard: In both 

cases clicking in the middle will bring the main dashboard. 

 

VLM Microboard 

 

 

The long arrow represents the winds direction. The red arrow is the current active WP direction, while 

the pink arrow is the direction corresponding to the best VMC toward the current active WP. Green arrow 

is TWD (red is not in allowed polar angles, yellow if just at that limit). You can click on the upper label to 

center the chart on boat. 
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Tactical Microboard 

  

Tactical Microboard shows much more data than VLM microboard. It can be oriented North-Up or Bow-

Up and can show laylines on active WP. 

Polar limits can be rotated according to TWD as in the previous images, or according to HDG: 

  

You can also ask for a transparent background in the central part of the board: Several other options are 

available: 
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Available data in Tactical Microboard 

 

TWD indicator will be either green or red, depending on polar limits. The rudder scale is limited to -

30°/+30° and the indicator will smoothly turn red when approaching 30° rudder angle. 

The start/stop NMEA button can have 4 colors: 

• White: NMEA acquisition is not started 

• Green: NMEA acquisition is started, and a GPS fix has been found. 

• Red: NMEA acquisition is started, but no GPS fix has been found. 

• Yellow: Simulation Mode is activated 
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Tactical Microboard on the chart or as a regular instrument 

Tactical Microboard can also be used as a regular instrument on the chart or in Custom Instruments 

panels (under the name “MBRD”). You can decide to center this instrument automatically on the boat. 
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Main Dashboard 

Position tab 

This tab shows boat’s geographical 

coordinates. It also allows to move the 

boat to a precise position by pressing 

“position” button. You can also reset or 

archive the boat’s trace from here.  

Button “?” can be used to export 

coordinates, course, and speed in 

Geodata format.  

 

Clicking on the boat image will close the 

main dashboard. 

It also shows sunset and sunrise date for 

the current date, and moon phase. 
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Speed and Heading tab 

 This tab shows boat’s speed and heading. 

 

 

 

 

 

 

 

 

 

WP tab 

This tab shows active WP information. DNM (Distance to Next 

Mark) is displayed, as well as NDNM (Next Distance to Next 

Mark), i.e., the distance between active WP and next mark, if 

active WP belongs to an active route or an active pathway. It 

also contains information about best VMC heading. 

It also shows a big LCD with the estimated remaining to active 

WP, based on boat speed and heading (not from grib/polar 

data). This is the same data as shown in the status bar. 

If active WP belongs to an active route or an active pathway 

then some other information is displayed, related to next mark 

rounding. These data can be computed based on active route 

and grib data or based on wind data as reported by instruments. 

It will also show Next Sail configuration do reach that POI if you 

have defined a sails configuration. 

Note that next TWA is red if wind is port side, and green if 

starboard. 

You can use “Next WP” button to activate the next POI in an 

activated route or pathway. Reset button will just deactivate 

current active POI. 
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NMEA tab 

This tab shows and 

commands NMEA 

activation. 

In the constellation 

picture please note that 

square satellites are 

from GLONASS. 

See NMEA connections 

documentation for 

more info. 
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Satellites constellations tab  

This tab shows satellites constellation, using 

TLE data (Two Lines Elements). Several 

constellations are predefined: 

 

TLE files can be downloaded directly from 

this tab. Note that it Is recommended to 

update these files once a week. 

Gray satellites are inactive. 

 

 

 

 

 

 

 

A list of satellites can also be displayed: 
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Anchor tab 

 
This manages Anchor Alarm. Anchor is also moveable with mouse, unless specifically locked on screen. 

Coordinates can also be directly captured. 

Alarm will ring whenever the boat’s distance to the anchor is larger than the one configured. The sound 

played is defined in the Alarms Module. 

You can also define a forbidden sector in the circle. 

An email can be sent if the option is checked. One mail will be sent when the boat exits the safe zone, 

and another one when it reenters it. There is a minimum interval of 5 minutes between emails. 

You can also choose ‘Send Position/COG/SOG” every 10 minutes, in which case an email containing this 

data will be send every 10 minutes if the boat is outside the safe zone. 

An email can also be sent when the anchor is positioned.  
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Polar tab 

This tab shows boat polar and display best 

wind angle upwind and downwind (left image). 

You can also click on the drawing to study the 

polar and show specific values for a given TWA 

(right image). 

If NMEA sources provide TWS, this value will 

be used when showing the polar in the board. 

The polar diagram can also be studied via the 

menu “Boat->Polar analysis”. 

The polar also shows current boat speed as a 

yellow dot, and PPC (Polar Percentage) in the 

data. 
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Weather Routing Module 

Introduction 

qtVlm uses isochrons method to calculate routings. This method consists in calculating all possible boat 

positions from a point, using grib data and polar, for a given time (step), and then to re-iterate this 

calculation until the arrival point is reached. 

To generate a routing, qtVlm uses boat’s polar (eventually adjusted by a performance coefficient), and 

gribs data Winds, Gusts, Currents, CAPE, Reflectivity and Waves. 

qtVlm has many functions concerning weather routing: pivot point, engine on or off, best starting date 

calculation (multi-routing), alteration of gribs data (what-if scenario), as well as many parameters to tune 

calculation precision versus calculation speed, depending of the machine. 

Weather Routing creation 

Creating a weather routing can be made either via a POI contextual menu, or via a right-click somewhere 

on the map (for mobiles versions Android and iOS via the pinpoint ), or via the menu “Routings-

>Create a routing”.  

    

You can in most cases run the routing with default options. Press the OK button, and qtVlm will calculate 

the best route toward the selected arrival point. 

Routing starting date can optionally be saved and restored from one routing to another. 
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Once the calculation has completed, you can convert this routing in a route, via “Routing->Edit a routing”, 

or via the routing contextual menu.  

If this option is checked before the calculation is launched, the conversion in route will take place 

immediately. 

  



216 
 

Converting a Weather Routing into a Route 

 

If you change the default starting date of the routing, or did not start the routing from the boat, you need 

to select “from routing start”. 

Conversion process also proposes to automatically simplify/optimize the resulting route. Simplification 

process will remove all useless points (for instance aligned points). Simplification can be optimum (i.e. it 

will keep more points), or maximum (which means that the process will try harder to remove points). 

At the end of simplification, an optimization phase will be proposed. The process will try to adjust POIs 

positions between the isochrons, to optimize the final ETA. 

These two phases are by no mean compulsory, but in general it gives better result, by mixing isochrons 

method with other calculation algorithms. 

Conversion to route may produce “red” POIs. These POIs are non simplifiable, because routing module 

has detected that they are important to avoid coasts or barriers. 

See Routes Module for more details on routes. 
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Multi-points routing 

A multi-points routing will follow a pathway, i.e. will route from one point to another until the end of the 

pathway. A pathway can optionally be closed. 

 

A POI can belong to several pathways: 
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Pathway starting options are carried over to the routing (starting point and dates). 
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Other Weather Routing Module functions 

Before running a routing, or after by editing it, several options and actions are available. 

Display TWS along and between isochrons 

 

This option allows to display wind speed (TWS) over isochrons. You can also change the grib date and 

the correspond isochron will be highlighted. There is also an option to animate grib during isochrons 

generation (this will slow down the computation) 
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Coloring isochrons according to interval from grib reference date  

The reliability of data in a grib depends a lot from the interval between this data date and the gribs 

reference date. The first 2 days of a grib are generally considered reliable (depending on models), and of 

course one must be extremely cautious with 16 days gribs. It is possible to color isochrons based on this 

interval: 

 

In that case, isochrons color will be white if interval <= 2 days, light gray if <= 5 days, gray if <= 8 days, and 

dark gray if over 8 days: 
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Displaying alternative routes  

You can request the routing to find and display alternatives to the main route. This is managed in the 

routing editor where you can specify a number for alternative routes and with which difference threshold 

(i.e. they must be completely different at least for the first half if the threshold is set to 50%). 

 

White routes are alternatives to the main green route. 
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Finding the best starting date: multi -routing 

It is common to search for the best starting date and time to reach a destination, based on various criteria 

like for instance duration, weather conditions during sailing, time with engine, number of tacks and gybes, 

rain, etc. 

The multi-routing function allows to generate several routings at fix time interval, and then to load them 

in a Route Comparator to compare them based on many criteria. 

You can also request multi-routings by varying polar efficiency or applying corrections to wind TWS, or 

select several gribs and compare routes generated using these gribs. 

 

Generated routes are then loaded in the route comparator. Data can be exported in CSV format, to be 

studied in spreadsheet. 

 

Data provided for comparison are: 

ETA, duration, sailed distance, average, maximum and minimum BS, average, maximum and minimum 

TWS, number of tacks and gybes, beating, upwind and downwind time, engine time, nighttime, rain, 

maximum CAPE, and maximum waves height.  
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Calculating and understanding inversed isochrons  

 

This function calculates inversed isochrons, i.e. it starts from arrival point and date and calculates from 

where it could have come to be there and starts again until it reaches starting point. This calculation 

allows to determine an envelope where regular and inversed isochrons are crossing. This envelop shows 

where the passage would be equivalent. A thin envelope is a clear sign that there is uncertainty in the 

routing because the passage found might well disappear on the next grib update. 

 

On this image, envelope is regular and large enough. The 

routing is probably stable and reliable. 
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On this other image, we can see that the “socket” is not regular and has a narrowing part, highly suspect 

and needing careful investigations: 

 

Isopoints 

Isochrons are made of isopoints. You can display useful information at each of them, like weather 

conditions, ETA, distance to destination etc. 
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Placing and utilizing pivots points  

Pivots points can be placed on isochrons, at isopoints. Their function is to force the routing to pass by this 

point, or even to restart from this point and continue routing using another destination. You can chain as 

many pivots as you want. Pivots points are inserted by pressing on the isochrons and calling their 

contextual menu. 

 

« Create a pivot point » will simply restart the routing there, continuing toward the same arrival. « Edit a 

pivot point » allows to edit the routing before, essentially to change arrival point (Edit a pivot is not 

possible if routing on a pathway). This function is useful to force passage points, or even to manage U-

turns. 
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Other options and advanced options  

Weather Routing Module allows you to choose automatic settings, depending on your machine resources 

and power. The slider automatically tunes calculation speed versus calculation precision. 

 

If you uncheck “Automatic Parameters”, you can modify manually various options. 
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• Isochrons parameters: you can define duration, time step and angle step. Duration can be 

different for the first and last 24h, where normally there are more obstacles to deal with. 

• VBVMG between isochrons: qtVlm uses a formula based on VMGs to calculate route from one 

isopoint to another. If you uncheck this option (not recommended) qtVlm will use a Great Circle 

path between isopoints. 

• Do not route outside screen: qtVlm detects only visible coasts, so if you allow it to route outside 

the current view it might not detect crossing coasts. In some rare cases it might be useful to 

deactivate this parameter. 

• Avoid coasts, avoid barriers: These options can be deactivated, resulting in a much faster 

calculation. Routing module uses by default GSHHS coast lines to detect land. You can 

choose to use vector charts or shapefiles coasts lines instead, which will be much more 

precise. 

• Maximum distance to Great Circle line: When this option is activated, routing will limit its search 

around the Great Circle line from start to arrival. This is useful to avoid finding points too far away, 

for instance when the grib is not very reliable. 
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• Circumvent angle: this option can be useful when the destination is completely obfuscated by an 

obstacle and the boat is too close from it for the routing to find a solution. In that case you can 

help it by specifying a deviation angle for the few first isochrons. 

 

• Use multithreading: Uses all CPUs for calculations. Some machines do not support that well (XP 

for instance) and need to have this option deactivated. 

• Forecast modifications: gribs data can be altered to follow some “what-if” conditions, like 

changes wind speed or shifting grib time. 

• Maximum and minimum winds: You can ask routing module to avoid areas with too strong or too 

weak winds. 

• Maximum waves height: You can ask routing module to avoid areas with waves height over a 

value. 

• And waves steepness is more than: If this is checked, then only waves exceeding maximum 

height and having a steepness over the setting will be avoided. If no steepness can be calculated 
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because there is no wave period in the grib, then a 0% steepness will be used and the wave will 

not be avoided even if its height exceeds the maximum height value. 

• Maximum CAPE: You can also ask routing module to avoid areas based on a maximum CAPE 

value. 

• Maximum Gusts: You can specify a maximum value for gusts, assuming of course the grib 

contains such data. 

• Maximum Reflectivity: You can specify a maximum value and the routing module will avoid areas 

with a greater value for Reflectivity. 

• Auto zoom: This option asks routing module to automatically zoom on routing area. Since qtVlm 

do not see coasts outside view, it is sometimes necessary to adjust the zoom level with the slider 

or even uncheck this option and manage the zoom manually before launching the calculation. 

Other parameters with impact on routing module 

Grib corrections 

See chapter Gribs corrections 

Vacation (crank) length 

This value can be modified via the menu “qtVlm->Configuration->Boat and Instruments”. It represents the 

internal step qtVlm is using for routes, routings and many other functions. For normal utilization, 5 

minutes is the recommended value. 

Grib interpolation formula 

This setting can be modified via the menu “qtVlm->Configuration->Advanced”. Spatial only and SOL 

interpolation mode are intended to be used for some simulation games and should not be used in real 

boat mode. 

Boat parameters 

Most of boat’s parameters have an influence on routing: 
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Polar efficiency upwind/downwind: Allows to tune the polar selectively. 

Night efficiency: Similarly, you can specify a polar coefficient for night periods. 

Best angles: Normally qtVlm calculates automatically best angles upwind and downwind based on the 

polar. You can override these values. 

Waves and Gusts: See Waves and Gusts parameters for more explanations. 

Engine: You can specify that below a sailing speed, you start the engine and indicate at which speed you 

navigate. In this case the routing will assume you go straight (i.e., best angles are ignored). 

Tacks and Gybes: By default, qtVlm considers you can tack and gybe at no cost and at every crank (5 

minutes). Of course, this is not realistic, and you should specify how long it takes to gybe and tack, plus 

eventually the loss of speed during these maneuvers. 

Grib selector: If a unique grib slot has been selected in the grib selector, then only this grib will be used to 

calculate the routing and eventually the resulting route. If later you decide to select another grib or all 

the gribs, you can freeze the generated route before so that it won’t be recalculated with the new 

selected grib(s). 
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Routing with Ensemble data  

Routing can also use Ensemble data (see Ensemble Gribs chapter). 

You can route on Control, Mean or Median elements. You can also create multi routings on all elements 

of an ensemble grib. 

For instance, routing on all ensemble control + all members: 

 

You can also decide to avoid areas where standard deviation is too high: 

  



232 
 

Routes Module 

Introduction 

Routes are lines connecting points, called POIs in qtVlm (Points of Interest). They can be created by hand 

or may come from a routing converted into a route or be imported from other system in various format. 

Routes use gribs data to calculate a way between POIs, taking boat polar into consideration as well as 

navigation mode defined at POI level. Calculation step (crank or vacation) is defined in “qtVlm-

>Configuration->Advanced”, with a default value of 5 minutes. 

By default, POIs in a route are reached in their alphabetical order. That can be changed to use a sequence 

number instead. 

Three navigation modes exist to navigate toward a POI: 

• VBVMG mode: This mode consists in navigating in Great Circle mode toward the POI, unless the 

polar indicates that not inside its VMG winds limits. If the polar indicates that the TWA is not 

within the VMG wind limits, the route will automatically start to tack or gybe to reach the WP. 

• VMG mode: This mode uses the best VMG to WP (VMC) to navigate toward POI. 

• GC mode: This mode uses Great Circle route to reach the POI, even if it implies to be too much 

upwind or downwind. 

 

These navigation modes are selectable from POI contextual menu, or through POI editor.  
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Creating or editing a route 

Creating a route is done via the menu “Routes->Create a route”, or if the route already exists edition is 

done via the menu “Routes->Edit a route”, or via its contextual menu. 

 

Several options are available, including most important starting point and starting date. You can also 

choose to show or not intermediate POIs, or to detect collision with land and barriers. You can alter grib 

data from grib and play with polar efficiency individually for this route. 

You can choose to hide the route if the display as scale bigger than scale minimum. 

If the route has been created manually, then you need to assign manually some POIs to it. This is made 

through the edition of POI, or via their contextual menu. 
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Converting a routing into a route  

At the end of a routing calculation, it is possible to convert it into a route (see Weather Routing Module 

documentation). 

 

Some POIs will appear in red. These POI are non-simplifiable points, generated by routing, and that 

cannot be removed or moved because they are useful to avoid coats or barriers. 

It is always needed to manage these points by hand (move or remove or add new), mainly because coasts 

lines used by qtVlm are not precise enough. 

Coasts or barriers collisions  

If the relevant option is checked, route will detect if it crosses a coastline or a barrier. If this is the case, 

that part of the route will turn red. 
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Simplification, Optimization and Complexification 

A route can be simplified and/or optimized. Simplification has two modes: optimum and maximum. 

Optimum mode will keep more points and will get better ETA, while maximum mode will keep only the 

strictly necessary points and remove all others. These functions can be called either from the route editor 

or from the route contextual menu. 

Please note that routing’s quality setting has also an impact on these processes. To achieve the best 

quality for Simplification or Optimization this auto setting should be deactivated or set to the 

maximum quality. Maximum quality implies longer calculations. 

  

These processes try to avoid coasts or barriers. Beware only visible coasts (i.e. displayed on the screen) 

are taken into consideration. The quality of the coast lines depends on the zoom level, so it is possible 

that a route avoiding coast at a certain zoom level will touch them at a closer level. By default qtVlm uses 

not very accurate GSHHS coasts lines, but you can choose to use vector charts coast lines instead. 

If an area is selected on the map, only the part of the route inside that area will be simplified/optimized. 

You can also decide to complexify a route. In that case a new POI will be inserted between each existing 

POI, and an optimization procedure will be initialized. 
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Add/remove POIs to route 

You can add or remove POIs from a route through its editor, or via its contextual menu. 

A POI can also be added where you want by right clicking the route and selecting ”New POI”. A POI will 

be inserted on the route at the mouse (or finger) position. 

  

Append POIs 

You can append new POIs to the route just by clicking or touching the screen. Since in this mode it is not 

possible to move the chart with a mouse pan, note that you can always use up/down/right/left keys or 

the corresponding buttons in the toolbar to pan the view. 

Moving POIs belonging to a route  

POIs belonging to a route are moved the same way as normal POIs. You should first click or tap on the 

poi then release it, and after a short time a blue circle appears on the POI, the POI becomes moveable 

and can be moved with mouse or finger. This is to avoid moving POIs accidentally, but you can choose to 

ignore this security in the general configuration screen. 
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Displaying Wind Arrows on POIs  

It is also possible to display icons next to POIs, representing the wind at the time of passage. The icons 

also show if it will be during day or night. Their size can be adjusted in the routes general options. 

 

Boat position extrapolation 

 

A big dot appears on the route when the grib date is moved forward. This corresponds to the position of 

the boat at that date. It can also be seen when animating gribs. 

This also allows to compare boat’s position on several routes. 

The route’s tooltip displays all weather information available at passage time. If configures the best sail’s 

configuration is also displayed in the tooltip. 

The yellow information is the wind data corrected with the difference between actual measured 

wind from instruments and grib wind at current boat position.  
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Route logbook 

The route’s logbook is available in the editor screen. It contains many information, that can be exported 

in CSV format. The button can be used to configure which columns are displayed or hidden. 

 

Warning: Winds information at route level includes wind generated by Currents, if this data is available 

in gribs. Consequently, wind data in route’s log might differ from pure wind grib data. 

It is also possible to export this in a CSV file, to be treated in a spreadsheet calculator. 

The last tab “Statistics” contains the following statistical data about the route: 
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You can show which coefficients have been applied on Polar Speed by hovering STW field with the mouse. 

 

Histograms 

Route’s weather data can be displayed as histograms: 
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Defining an XTE reference 

A route can be set as XTE (Cross Track Error) reference. This is done through the route’s contextual menu. 

 

Once an XTE reference is defined, a small dashed line will appear that represents the track that was 

planned. The distance to this line is shown in the XTE instrument, and the position where the boat should 

be on this track is also shown. 
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Routes comparator  

Via menu “Routes->Routes comparator”, you can compare routes based on many criteria. 

 

Exporting and importing routes  

Routes can be imported and exported in a variety of format, kml and gpx being the most common ones. 

Imported routes are automatically frozen to keep their original data concerning ETA. You can uncheck 

this option later in the route’s editor. 

On iOS exported routes are place in iTunes shared folder, and the name of the file is always qtVlmRoute 

(.gpx, .kml, etc.). A route to be imported should also be placed there, and its name cannot be 

qtVlmRoute. 
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General parameters and custom fields  

General configuration screen has a Route tab, which allows you to define most default values for routes. 

 

Route Custom Fields  

You can define up to three custom fields for routes. These values will be evaluated at each route’s step, 

and will be visible in route’s logbook, route’s statistics, and route’s tooltip. They are calculated based on 

a formula defined by the user, which is in fact a Javascript code. It can use the following variables: 

ETA (current timestamp), LON/LAT (boat’s Longitude/Latitude), CTW (Course through Water), STW 

(Speed through Water), COG (Course over Ground), SOG (Speed over Ground), TWD (True Wind 

Direction), TWS (True Wind Direction), TWA (True Wind Angle), AWS (Apparent Wind Speed), AWA 

(Apparent Wind Angle), CS (Currents Speed), CD (Currents Direction), DNM (Distance to Next Mark), 

CNM (Course to Next Mark), ENG (engine on), Gust (Gust Speed), DAYL (Day Light), CLOUD (% of cloud 

cover), AIRT (Air Temperature), PREC (precipitations), Cape (Cape), WMH (Max Waves Height), WMD 

(Max Waves Direction), WCH (Combined Waves Direction), LDIS (Distance travelled during this step), 

PLON/PLAT (Longitude/Latitude of active POI), ICE (ice density). 

In addition, it is possible to use a polar file to generate a value based (interpolated) on couple (TWS, TWA). 

If this option is activated, then the variable name will be CPOL. 

PERM_1, PERM_2, and PERM_3 are “permanent” variables which you can use to store values from 

previous steps. 
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The 3 fields need a name, a short name, units and eventually a way to accumulate them (“Sum”, 

“Average”, “Integration” or “Last Value”). The short name is used in the formula. 

It is possible to calculate many things that way. For instance, let’s imagine you want to calculate current 

produced by a wind turbine: 

var myAWS = AWS * 0.514444; //knots to m/s 
if(AWS > 30.0) 

myAWS = 20.0 * 0.514444; 
var S = 1.0; // surface 
var rendement = 0.2; // rendement 
var P = 0.0; 
if(AWS > 6.0 && AWS < 40.0) 

P = 0.37 * rendement * S * Math.pow(myAWS, 3); //puissance instan-

tanée 
P = P / 12.0 // Ampere 
AMP = P; 

 
 

The first field is a bit special: it can also carry its history, defined as a Java array. For instance, if your first 

field is called “MFIELD”, you have access to its previous value through the array “PREV_MFIELD”. Let’s 

imagine you want to count the number to tacks and gybes. You need to define 2 fields, let’s call them 

LTWA and VIRS, then a script that will look like this: 

LTWA = TWA; 
var pTWA = 0.0; 
var nb = PREV_LTWA.length; 
if (nb > 0) 

pTWA = PREV_LTWA[nb - 1]; 
VIRS = 0.0; 
if (pTWA * TWA < 0) 

VIRS = 1.0;  

By defining accumulation of “VIRS” to be “by total”, you will get the number to tacks/gybes. 
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The same result can be achieved more efficiently by using one of the “permanent” variables: 

VIRS = 0.0; 
if(PERM_1 * TWA < 0) 

VIRS = 1.0; 
PERM_1 = TWA 

You can also define functions, use while/for loops etc. For instance, a function: 

function myPow3(i){return Math.pow(i, 3);} 
 

Values calculated like that are shown in route’s logbook, route’s statistics and route’s tooltip. 
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Pathways module 

A pathway is a list of POIs that represents for instance marks to be reached in order. 

 

 

You can choose to hide a pathway when the view is zoomed over a limit.  
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The pathway editor dialog contains an Information and Management tab containing data about the 

pathway and its legs: 

 

From there you can add, suppress, and change POIs order (assuming order is set to “By Sequence”, which 

is the default. You can also specify a speed for each leg. 

Pathways can be exported or imported via the Pathways menu. You can insert or append POIs via its 

contextual menu, and you can also close and/or revert a pathway. 

A POI can belong several times to the same pathway, and/or can belong to several pathways. 

Note that when appending POIs to a pathway, you can still pan the chart with up/down/right/left keys or 

the corresponding buttons in the toolbar. 

COG, TWA and Sail columns are the values for sailing from this POI to the next POI. COG may differ from 

Bearing if for instance the next POI is completely upwind, depending of course on your polar. 
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When data is live, you can show an instrument-like reduced view showing just the dynamic data 

 

  



248 
 

Routing on a Pathway 

A pathway can be used to generate a routing, in which case the routing (and eventually the resulting 

route) will reach each point in order. 

 

Using a Pathway as a measuring tool  

The pathway will display a lot of information in its tooltip, plus information labels are generated while 

moving POIs belonging to a pathway. Useful for measuring distances and angles: 

 

Note that through the pathway contextual menu you can make the pathway movable. 
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Activating a Pathway 

Like a route, a pathway can be activated. The first POI will become the active WP, and qtVlm will 

automatically switch to the next POI when the boat is entering the arrival radius of the POI. You can force 

the next POI activation from the pathway’s contextual menu: 

 

Contrary to routes which calculate ETAs based on boat’s polar and grib data, pathways compute 

ETAs based on actual boat speed, or based on speed that have been input in the Information and 

management tab. It is therefore convenient when motoring. 

First POI ETA is based on VMC, and next POIs ETAs are calculated using boat’s speed. 
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POIs tooltips show ETA in date form instead of time-to-go. 

If a POI belongs several times to a pathway, only its next arrival date is displayed. To know its other dates 

of passage, you can edit the pathway and show Information: 

 

Please note that activated pathways also activate XTE calculations. 
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Security shape 

You can request a security shape around the pathway. 

 

 

Max distance is the distance qtVlm will check from the pathway for dangers (orange) or obstacles (red). 

It will try to shrink the safe path until it reaches the Min distance, declaring it red (grounding alert). 
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POIs and Barriers 

POIs (Points of Interests) 

Introduction 

POIs are points (Points of Interest) placed on the map. They can belong to a route or a pathway, be used 

as starting or arrival points for a routing, be declared as active WP, etc. 

POI creation and edition 

POI editor is called via its contextual menu. 

 

Coordinates can be input in both formats. 

There are 3 types of POIs: classical, Mark or Beacon. The only difference being their color on the map. 

It is possible to copy/paste a POI, or to center the chart on the POI. 

Creating a POI can also be done via right-click menu somewhere on the map (or with the pinpoint for 

mobile versions). 

Moving a POI can be done with mouse or finger. On PC versions, if you press SHIFT before releasing the 

POI, it will come back to its initial position. 
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You can also input a comment (512 characters max) and attach an image that will be displayed in the POI 

tooltip. 

A scale minimum can be decided, in which case the POI will show only when the scale reaches this 

minimum. 

The indications “Pass as close as possible” and “Leave on” (Unspecified/Starboard/Port) are used only 

when the POI belongs to a pathway that is used for routing. Note that if the pathway is reversed then the 

indication “Leave on” will be reversed too. 

Marks Management 

From the mark menu you can show the POIs management dialog. This allows you to delete, export, edit 

or center on POIs. 

 

Note that all POIs inside the selection zone will be automatically selected when opening the dialog. From 

this dialog you can also call the Archive module, which allows you to manage a library of POIs archives: 
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To insert new POIs in an archive, they must be selected in the previous dialog (POIs management).  
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Mark menu 

Mark menu proposes various action concerning POIs 

 

POIs can be imported from other sources or from a gpx file. 
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AVURNAVs 

From the Charts menu you can also request “AVURNAVs” and “AVINAVs” (French authorities notice to 

navigators) for areas Navarea 2, Cherbourg (France Channel), Brest (France Atlantic) and Toulon (France 

Mediterranean Sea). 

 

AVURNAVs and shown in red, AVINAVs in blue. 

 

Note that you can define an Avurnav as an obstacle or a danger. An obstacle will be avoided by routings 

and routes, while a danger will trigger various alarms.  
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POI contextual menu 

 

Most actions related to POIs are available in its contextual menu. For action “draw a heading” or “draw a 

grib reckoning” see chapter concerning qtVlm environment, for Route sub-menu see chapter concerning 

Routes module. 
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Line between POIs 

You can draw lines between POIs, for instance to materialize a starting or an ending line. 

 

Once created, the line shows in its tooltip various information regarding directions and distances 

 

This function can also be used to find the position of an object, by placing several such lines. Place the 

first POI on the boat and the second one in the measured bearing of the object and repeat the operation 

several times when the boat has moved enough. The object approximate position will be where the lines 

are crossing. Useful for instance to find the position of a mark during racing. 
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Great Circle passing through the boat  

It is also possible to draw a GC circle passing through the boat. This is useful for instance to know if you 

are in advance or not in a fleet racing. 

 

  



260 
 

Laylines 

You can display two types of laylines from a POI: laylines calculated from gribs data, or/and laylines 

calculated with NMEA data. In both cases, Currents data are taken into consideration if available. Grib 

laylines are rendered with dashed lines. 

 

Historical variations of NMEA laylines can be shown as well. The duration of harmonics history is 

configurable in the main settings, boat’s tab. You can reset harmonics history from the POI contextual 

menu. 

Grib laylines will use current grib display date unless NMEA acquisition is started, in which case current 

date and time will be used. 

Laylines show a label with some critical information, and a black dot showing for each one the best 

position to target on the layline, according to your polar. 
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Barriers 

Barriers management is done via the menu “Barriers”. 

 

Barriers are positioned with mouse or finger. Once placed you can move points, add/remove points, close 

the barrier, etc. 

 

Barriers are used by Weather Routing Module and Routes Module. They can be used to force a passage, 

to define a No Sailing Zone, etc. 

Barriers can also be defined as “slow zones”, if they are closed areas. In that case you can specify a slowing 

factor which will be used by Routes and Routings modules. 
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This feature is especially useful when navigating in Sargasso areas for instance.  

Barriers can be locked on the screen, to avoid moving them by mistake while moving the map. 

Since version 5.8.2, barriers can be exported and imported. 
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Batch mode 

Besides being able to open a grib directly from the command line (just type “qtVlm name_of_grib_file” 

on the command prompt), qtVlm is also able to run batch commands, either from the command line or 

from qtVlm menu. 

To do that, you must place the commands in an xml files, between a general <runs></runs>, each block 

of command being inside a <run></run> tag. 

For instance, this small xml file will start NMEA reception and record it, then will display a message, wait 

for 60 seconds and exit qtVlm: 

 

You can launch it either from qtVlm main menu, or via the command line, something like  

qtVlm run.xml 
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Supported tags 

The following tags are supported: 

<quit>true</quit>     <!-- qtVlm exit --> 

<wait>seconds</wait>      <!--  wait n seconds --> 

<waitUntil>MM/dd/yyyy hh:mm:ss</waitUntil> <!-- wait until this date (UTC) --> 

<userMessage>text</userMessage>  <!-- display a message --> 

<takeScreenShot>fileName</takeScreenShot> <!-- take a screnshot and save it in fileName --> 

 

Note : This 5 tags are exclusive, meaning that they should be alone in their <run></run> tag 

<exportRoutesLogs>true</exportRoutesLogs > <!—Exports all routes logs --> 

<exportFolder>folder</exportFolder>  <!—Export folder (not compulsory) 

Note: These 2 tags must be unique in their <run></run> 

<startNmea>false</startNmea>  <!-- NMEA reception starts or stops  --> 

<nmeaLogFile>fileName</nmeaLogFile> <!-- NMEA log file name --> 

<closeAllGribs>true</closeAllGribs>  <!-- Close all gribs --> 

<clearAllRoutes>true</clearAllRoutes>  <!-- Delete all routes --> 

<gribSlot1>fileName</gribSlot1>  <!-- Grib file for slot1--> 

<gribSlot2>fileName</gribSlot2>  <!-- Grib file for slot2--> 

<gribSlot3>fileName</gribSlot3>  <!-- Grib file for slot3--> 

<routingName>name</routingName>  <!-- Routing name --> 

<startPoint>POI name for starting</startPoint> <!-- If empty or missing routing starts from boat --> 

<endPoint>POI name for arrival</endPoint> <!-- Arrival for routing--> 

<startDate>MM/dd/yyyy</startDate>  <!-- Start date (UTC) --> 

<startTime>hh:mm:ss</startTime>  <!-- Start time (UTC) --> 

<noRouteOutsideScreen>false</noRouteOutsideScreen> <!-- default true --> 

<multiRouting>true</multiRouting>  <!-- Multi routing activated true/false --> 

<generateRoutes>1</generateRoutes>  <!-- Nb of routes to be generated --> 

<stepDays>1</stepDays>   <!-- Days step (multi-routing) default 1--> 

<stepHours>0</stepHours>   <!-- Hours step (multi-routing) --> 

<stepMins>0</stepMins>   <!-- Minutes step (multi-routing) --> 

<comparatorCsvFile>fileName</comparatorCsvFile> <!—Output file for comparator --> 

<convertToRoute>false</convertToRoute> <!-- Automatic route convert (single routing only) --> 

<autoSimpOptim>false</autoSimpOptim> <!-- With simplification/optimization--> 
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Examples 

Launching a multi-routing 

 

Launching a single routing 
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qtVlm Companion 

qtVlm Companion is an Android application also compatible with Android-Wear (watches). It serves as a 

light repeater for qtVlm, and is able to show data, but also charts, AIS, WP information, Anchor, etc. 

There is also an iOS version, only for iPhones or iPads. 

 

See Companion documentation for more details. 

  

http://download.meltemus.com/qtvlm/companion_documentation_en.pdf
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Tutorial Videos 

David Burch from Starpath school has made some very nice tutorial videos: 

https://www.starpath.com/qtVlm/qtVlm_playlist.html 

Also don’t miss David’s excellent cheat sheet about qtVlm, a work in progress but many useful tips inside: 

https://www.starpath.com/qtVlm/ 

https://www.starpath.com/qtVlm/qtVlm_playlist.html
https://www.starpath.com/qtVlm/

